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About this document

The IBM® WebSphere®™ Business Integration Server Express and IBM®
WebSphere® Business Integration Server Express Plus are made up of the
following components: InterChange Server Express, the associated Toolset Express,
Collaboration-Foundation, and a set of software integration adapters. The tools in
Toolset Express help you to create, modify, and manage business processes. You
can choose from among the prepackaged adapters for your business processes that
span applications. The standard processes template--CollaborationFoundation--
allows you to quickly create customized processes.

This document describes the installation, configuration, and business object
development, and troubleshooting for this specific software integration adapter.

Except where noted, all the information in this guide applies to both IBM
WebSphere Business Integration Server Express and Express Plus. The term
"WebSphere Business Integration Server Express” and its variants refer to both
products.

Audience

This document is for consultants, developers, and system administrators who use
the connector at customer sites.

Related documents

The complete set of documentation available with this product describes features
and components common to all WebSphere adapter installations, and includes
reference material on specific components.

You can download, install, and view the documentation from the following site:
http:/ /www.ibm.com/websphere /wbiserverexpress/infocenter

Typographic conventions

© Copyright IBM Corp. 2004, 2005

This document uses the following conventions:

courier font Indicates a literal value, such as a command name, file
name, information that you type, or information that the
system prints on the screen.

bold Indicates a new term the first time that it appears.
italic, italic Indicates a variable name or a cross-reference.
blue outline Blue outline, which is visible only when you view the

manual online, indicates a cross-reference hyperlink. Click
inside the outline to jump to the object of the reference.

\ In this document backslashes (\) are used as the convention
for directory paths. All WebSphere Business Integration
Server Express product pathnames are relative to the
directory where the product is installed on your system.

ProductDir Represents the directory where the WebSphere Business
Integration Server Express Adapters product is installed. The
default product directory for each platform is:
\IBM\WebSphereServer.
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In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

In a syntax line, a pipe separates a set of options from which
you must choose one and only one.

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

Angle brackets surround individual elements of a name to
distinguish them from each other, as in
<server_name><connector_name>tmp.1og.
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New in this release

New in release 2.2.0

Support is no longer provided for Solaris 7.0.

Connector definition file format has changed from .txt to .xsd.
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Chapter 1. Overview of the adapter

This chapter describes the IBM(R) WebSphere(R) Business Integration adapter for
eMatrix(R) and the associated system architecture.

MatrixOne eMatrix(TM) is a product lifecycle management solution that enables
users to centralize control over all documents and data flows related to the product
life cycle, and to monitor access to them. The adapter for eMatrix enables
bidirectional, real-time integration between the eMatrix global collaboration
platform and other enterprise applications.

The adapter communicates with the eMatrix collaboration server, which is installed
separately from the application itself. For details on downloading and installing

the eMatrix collaboration server, refer to the eMatrix documentation.

For more information about the relationship of the integration broker to the
adapter, see the System Administration Guide.

This chapter contains the following sections:

* [“Adapter architecture” on page 1

+ |“Architectural overview” on page 2|

+ |“Event notification” on page 3|

Adapter architecture

The adapter for eMatrix consists of a connector, the Java Program Object (JPO), and
an Object Discovery agent (ODA) with the adapter framework. Together they
enable eMatrix to exchange information with an integration broker, and thereby to
communicate with external applications such as accounting and CRM packages.

The adapter includes three primary components:
¢ Connector

Acts as an intermediary between the integration broker and the application in
the transfer of data. The connector is metadata-driven.

* Java Program Object (JPO)

There may be more than one. They run within eMatrix and they store
information about events in the eMatrix database.

* Object Discovery Agent (ODA)

A design-time tool that queries the application to determine existing eMatrix
business object types and relationships. These form the basis of the WebSphere
business object definitions. The connector uses these definitions at run time to
convert application data into business objects.

The adapter manipulates eMatrix business objects and connections within eMatrix.
It may also execute MQL statements. Through the use of MQL commands, the

adapter can perform almost any action supported by eMatrix.

The adapter communicates with the eMatrix application using a Java-based API
called the eMatrix adapter development kit (ADK) and a separate eMatrix

© Copyright IBM Corp. 2004, 2005 1



Integration
Broker

collaboration server. The eMatrix ADK enables the adapter to query and
manipulate objects in the application by passing requests to the application
through the eMatrix collaboration server.

Architectural overview

The adapter mediates data flows to and from the integration broker and the
application. The flows are:

* Request processing, initiated by the integration broker (InterChange Server
Express)

* Event processing, initiated by the eMatrix application

These flows are described in detail below.

Request processing

Request processing starts with the integration broker. The integration broker passes
business objects to the adapter for eMatrix, which communicates with the eMatrix
collaboration server using its Java-based eMatrix ADK. [Figure 1 on page 2| provides
an architectural overview of the data flow.

BO request

Adapter

for eMatrix ol eMatrix_
Collaboration
Server

\ 4

A 4
eMatrix System

Figure 1. Request processing in the eMatrix adapter

Request processing takes place as follows.

1. The integration broker issues a request to the adapter in the form of a business
object, which contains type information and a business object verb.

2. The adapter processes the business object by invoking the appropriate eMatrix
ADK calls.

3. Each time an eMatrix ADK call is made, the collaboration server performs the
specified action on the corresponding object in the eMatrix system and returns
the result to the connector.

4. Once the adapter has finished processing the request, it returns a status code

and if required, a business object with the resulting changes, to the integration
broker.
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Event notification

The adapter for eMatrix uses event polling to detect events in the eMatrix system
at run-time. [Figure 2 on page 3 illustrates the sequence of events that occurs when
the application is polled by the integration broker through the adapter.

Note: For polling to work, you must first configure an eMatrix trigger for the
event or events you wish to monitor. This is done during the initial setup.
For details, refer to|“Configuring the adapter” on page 11}

eMatrix System

Adapter Integration
for eMatrix Broker

pollForEventS

trigger
JPO

creates...

API

BO event

Figure 2. Event notification in the eMatrix adapter

Event notification takes place as follows.

1. An action is performed in the eMatrix system, causing a trigger to fire.
Triggers can be invoked in many different ways, for example, such as
modifying an eMatrix object with a configured trigger.

2. When the trigger is fired, the eMatrix system executes the associated Java
Program Object (JPO), which creates a new event object in eMatrix.

3. At specified intervals, the adapter polls eMatrix for any new event objects that
the JPO has created.

4. The adapter retrieves the event object.

5. It then retrieves the relevant eMatrix entities, translates them to business
objects, and publishes them to the integration broker. The adapter can retrieve
both eMatrix business objects and relationships.

How the adapter works

The adapter for eMatrix is bi-directional. It can process events originating from the
eMatrix system, and requests sent by the integration broker to the eMatrix system.

Chapter 1. Overview of the adapter 3



Event notification

The adapter detects and processes events through a polling mechanism. This
allows you, as the user, to set event priorities and control the frequency of event
detections and the number of events that the adapter can process. With this level
of control, you can balance the adapter load within the larger system and smooth
the path of any critical events. These values are set in the adapter’s configurable
properties (see [“Configuring the connector” on page 12).

The adapter makes use of Java Program Objects (JPOs) and eMatrix business object
definitions to store and transmit information about events. IBM provides two
default JPOs, which you may use if you choose. They are:

* The WBIEventLogger JPO, which creates the business object type that records
events

* The InstallEventTables JPO, which creates the business object type that stores
event

The text assumes that you are using the default WBIEventLogger JPO. For details
on the structure of eMatrix objects, refer to [Chapter 4, “Understanding business|
fobjects,” on page 19|

The WBIEventLogger JPO is the crux of event notification. You can define triggers to
invoke this JPO whenever any action is associated with a specific business object
or relationship. The JPO uses the object ID and the specified options to create a
new event business object or relationship in eMatrix.

For example, if you want to track events involving an object type called “Part
Assembly”, you can configure eMatrix to invoke the JPO when such actions occur.
When the trigger fires, the JPO records the PartAssembly ID and the type of action
taken during the event.

For details on defining triggers, refer to [’Configuring the JPOs” on page 11|.

Note: Event notification is an asynchronous process. The adapter does not support
synchronous event notification.

Event retrieval

When the adapter polls the application, it queries eMatrix for unprocessed events.
It checks for all events that have a value of READY_FOR_POLL for the
configuration property EventStatus. The adapter retrieves the event records that
the WBIEventLogger JPO has created.

All events exist in the same vault. The adapter reads the EventVault property value
in at startup.

The adapter then retrieves the associated eMatrix object and sends it to the
integration broker. The adapter may also archive the event in eMatrix once it has
been published to the integration broker.

Information about events is held in the eMatrix objects called “<prefix>_Event” for
unprocessed events, and “<prefix>_Archived_Event” for processed events. The
adapter uses status codes to track the state of events.

If the adapter terminates unexpectedly, it may report “in-doubt” events when it is
restarted. An event is labeled in-doubt when the adapter is unable to determine

whether it was successfully published to the integration broker or not. The adapter

4 Adapter for eMatrix User Guide



must process these events before it attends to any normal events. For details on
what actions it takes, refer to [‘Processing errors” on page 39|

Sample scenario

The adapter for eMatrix includes a sample scenario that illustrates how the adapter
handles request processing and event notification. For information on installing,

configuring and running this scenario, refer to [Appendix C, “Sample scenario,” on|

Chapter 1. Overview of the adapter 5
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Chapter 2. Installing the adapter

This chapter describes how to install the IBM WebSphere Business Integration
Server Express adapter for eMatrix. It contains the following sections:

+ [“Adapter environment”|

* [“Overview of installation tasks” on page §|

* [“Installing the adapter and related files” on page 8|

* [“Installed file structure” on page §

Adapter environment

Before installing, configuring, and using the adapter, you must understand its
environment requirements. They are listed in the following section.

+ |[“Adapter platforms”]

+ [“Adapter dependencies”]
* [“Globalization”]

Adapter platforms

The adapter is supported on the following software.
Windows 2000

Databases:
e DB272
e Qracle 8.1.7.4, Oracle 9.2.0.1

Third-party software:
e eMatrix Server versions 9.6.01, 10.0.0.0
¢ eMatrix Collaboration Server versions 9.6.01, 10.0.0.0

Adapter dependencies
The adapter client library/API resides in eMatrixServietRMI.jar version 10.0.0.0.

The adapter requires access to the eMatrix ADK at run time. The ADK is
distributed with the eMatrix collaboration server and in a stand-alone version.

If you have the adapter installed on the same machine as the eMatrix collaboration
server, you need not download the stand-alone version of the ADK. However, if
the adapter and collaboration server are on two different machines, you must
install the stand-alone ADK on the same machine as the adapter.

Globalization
This adapter is DBCS (double-byte character set)-enabled and is translated.

© Copyright IBM Corp. 2004, 2005 7



Overview of installation tasks

Follow these steps to install the adapter for eMatrix.

1. Make sure the integration broker is installed.

Make sure all the prerequisite software is installed.

Make sure you know the names and locations of any remote eMatrix servers.
Install the adapter for eMatrix and related files.

ok~ wpn

Configure the adapter for eMatrix.

The installation instructions in this guide cover steps 4 and 5.

Installing the adapter and related files

For information on installing WebSphere Business Integration Server Express
adapter products, refer to the WebSphere Business Integration Server Express
Installation Guide for Windows. The guide is located in the WebSphere Business
Integration Server Express Adapters Infocenter at the following site:

http:/ /www.ibm.com /websphere /wbiserverexpress/infocenter.

Installed file structure

shows the file structure used by the adapter and lists the files that are
installed on the system.

Notes:
1. This document uses (\) backslashes as the convention for directory paths.

2. All product path names are relative to the directory where the product is
installed on your system.

Table 1. Adapter files installed on system

Subdirectory of ProductDir Description
\bin\Data\App\eMatrixConnectorTemplate Template for the eMatrix connector
connectors\eMatrix Contains:

* CWeMatrix.jar
* start_eMatrix.bat

connectors\eMatrix Contains the startup script for the connector service:
eMatrix_service.bat

connectors\eMatrix\dependencies Contains default JPOs:
e InstallEventTables.java
* WBIEventLogger.java

connectors\eMatrix\samples Contains sample connector configuration files:
* EmatrixConnector.cfg

e PortConnector.cfg

* repos

* sound_card_update.bo

8 Adapter for eMatrix User Guide



Table 1. Adapter files installed on system (continued)

Subdirectory of ProductDir

Description

connectors\eMatrix\samples\repos

Contains sample business and relationship objects:
e wbi_bundle.xsd

* whi_computer.xsd

> wbi_computer_bundle_to_computer.xsd

e wbi_computer_computer_to_pci_component.xsd
* wbi_computer_to _pci_component.xsd

e wbi_cpu.xsd

* whi_cw_event.xsd

* whi_expand_bo.xsd

e wbi_input.xsd

* wbi_network card.xsd

* wbi_sound_card.xsd

* wbi_sound_card_sound_card_to_sound_chip.xsd
* wbhi_sound_chip.xsd

e whi_ush_2 0 _card.xsd

connectors\messages

Contains the eMatrixConnector.txt file, which lists
error and other messages.

ODA\eMatrix

Contains:

* eMatrixODA.jar
The Object Discovery Agent, which has the ODA code

* start_eMatrixODA.bat

ODA\messages

Contains the eMatrixODAAgent.txt file, which lists
error and other messages.

Chapter 2. Installing the adapter
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Chapter 3. Configuring the adapter

This chapter describes how to configure and start the adapter for eMatrix. It

contains the following sections:

+ [“Configuring the adapter”]

+ |“Creating multiple connector instances” on page 14|

* |“Starting the connector” on page 15

+ [“Starting the eMatrix adapter” on page 16|

* |“Stopping the connector” on page 16

« [“Using log and trace files” on page 16|

Configuring the adapter

After installation and before startup, configure the adapter components as follows.

Configuring the JPOs

The JPO triggers require certain configuration properties to be set before they will
work. To set these configuration properties, you have to edit the source code for

each JPO.

The JPOs installed with the adapter for eMatrix are WBIEventLogger and
InstallEventTables. After you have installed them, you must locate each JPO in

the eMatrix Business Modeler and edit the source code.

The fields that need to be edited are listed below in [Table 2 on page 11}

Table 2. JPO configuration properties

Property name

Description

Default value

wbiPrefix

The prefix used to provide all WebSphere Business Integration
eMatrix meta-entities (types, attributes and policies) with their own
namespace within eMatrix. The value specified for

wbiPrefix in the connector configuration properties must

match the wbiPrefix declared in the InstallEventTables

and WBIEventLogger.java files.

wbi_

vault

Name of the eMatrix vault in which new events will be created.
Must match the value specified for the EventVault connector
configuration property.

WBI_Events

adapterUser

The ID that the adapter uses when making requests in the eMatrix
system. Must match the value specified for the ApplicationUserName
connector configuration property. Important for preventing the
“Ping-pong” effect (see below).

adapter

Preventing the ping-pong effect

When the adapter modifies an object in the eMatrix system for which a trigger is
assigned, that trigger may in turn generate a new event to be published back to
the broker. The following mechanism prevents this from happening.

When a JPO is invoked, it receives a Context object that contains, among other
things, the userID associated with the user who invoked the JPO. This user ID is

© Copyright IBM Corp. 2004, 2005
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set in the JPO property adapterUser. When it is triggered, the WBIEventLogger JPO
checks the user ID it receives from the eMatrix Context object.

If the user was the adapter for eMatrix, the value of the JPO’s adapterUser
property will match the value of the connector’s ApplicationUserName property. In
this case, the JPO will ignore the event, and it is not logged. If the user IDs do not
match, the JPO creates a new event.

Note: It is important to set the adapterUser property in the JPO and the
ApplicationUserName property in the adapter to the same values, otherwise
you get the ping-pong effect.

Configuring the connector

The connector component of the adapter has two types of configuration properties:
standard configuration properties, which apply to most adapters, and
application-specific configuration properties, which apply only to your adapter.
You must set the values of these properties before running the connector.

Standard configuration properties

To configure the standard connector properties, use the Connector Configurator
Express tool. Details are given in [Appendix B, “Connector Configurator Express,”|
This tool provides a graphical user interface for configuring the
connector. Select the Standard Config Properties tab to add or modify
configuration properties.

When you have finished specifying values for the connector’s configuration
properties, Connector Configurator Express saves the values in the adapter
repository for InterChange Server Express.

A connector obtains its configuration values at startup. During a run-time session,
you may want to change the values of one or more connector properties.

* Changes to some connector configuration properties, such as AgentTracelevel,
are dynamic, taking effect immediately.

* Changes to other connector properties are static, requiring component restart or
system restart after a change.

To determine whether a property is dynamic or static, refer to the update method
column in Connector Configurator Express.

Application-specific configuration properties

Application-specific connector configuration properties provide information related
to the application and needed by the connector at run time. They also provide a
way for you to change static information or logic within the connector without
having to recode and rebuild it.

To configure these properties, use Connector Configurator Express. Select the
Application Config Properties tab to add or modify configuration properties. For
more information, see [Appendix B, “Connector Configurator Express,” on page 65

lists the application-specific configuration properties for the connector,
along with their descriptions and possible values.
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Table 3. Application-specific configuration properties for eMatrix

Property Description Possible values Default value Required
ApplicationUserName |Name used when <any> WBI Yes
connecting to the eMatrix |Must match the value
system. set for the adapterUser
JPO configuration
property
ApplicationPassword | Password used when <any> WBI Yes
connecting to the eMatrix
system.
EventVault Vault in which the <any> WBIEventVault Yes
adapter searches for Must match the value
events. set for the vault JPO
configuration
property
inDoubtEvents Recovery strategy One of: Reprocess Yes
for in-doubt events. + FailOnStartup
If no value is given, ‘R
the adapter will fail eprocess
on start-up. * LogError
e Ignore
ArchiveProcessed If True, the adapter true or false false
archives all events.
If False or undefined, the
adapter deletes events
from eMatrix after
they have been processed.
DefaultVault Default vault in <any> DefaultWBIVault
which the adapter creates
new objects and
manipulates existing ones.
DefaultPolicy Default policy used <any> DefaultWBIPolicy
by the adapter when it
creates new objects in
eMatrix.
KeepRelations If true, the adapter true or false false
maintains relationships
when it updates
business objects.
If false, it destroys any
relationships that are not
defined in Update
requests.
UseDefaults The adapter uses true or false true
the defaults set in the
business object definition
if UseDefaults is set
to true.
PollQuantity The maximum number <any positive 1
of events that the adapter |integer>
can process for each
poll call.

Chapter 3. Configuring the adapter
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Table 3. Application-specific configuration properties for eMatrix (continued)

Property Description Possible values Default value Required
WBIPrefix The prefix of all <any> wbi_
business objects and Must match the value
attributes related to event |specified for the JPO
notification in the eMatrix |wbiPrefix configuration
system. property.
Note: No pre-existing
business objects or
attributes may
start with this value.
EmatrixServer The name of the remote <any> :bos
business object server.
Hostname The URL of the <any> localhost:1099
collaboration server.

Creating multiple connector instances

Creating multiple instances of a connector is in many ways the same as creating a
custom connector. You can set your system up to create and run multiple instances
of a connector by following the steps below. You must:

* Create a new directory for the connector instance
* Make sure you have the requisite business object definitions
 Create a new connector definition file

* Create a new start-up script

Create a new directory

For Windows, the directory is ProductDir\connectors\connectorInstance

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file, create
this directory and store the file here:

ProductDir\repository \connectorInstance
where connectorlnstance uniquely identifies the connector instance.

You can specify the InterChange Server Express server name as a parameter of
startup.bat; an example is: start_ EMATRIX.bat connName serverName.

Create business object definitions

If the business object definitions for each connector instance do not already exist

within the project, you must create them.

1. If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer
Express to import them. You can copy any of the files for the initial connector.
Just rename them if you make changes to them.

2. Files for the initial connector should reside in the following directory:
ProductDir\repository\initialConnectorInstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

14 Adapter for eMatrix User Guide




Create a connector definition

You create a configuration file (connector definition) for the connector instance in
Connector Configurator Express. To do so:

1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Create a start-up script
To create a startup script:
1. Copy the initial connector’s startup script and name it to include the name of
the connector directory:
dirname

2. DPut this startup script in the connector directory you created in
[business object definitions” on page 14|

3. Create a startup script shortcut.

4. Copy the initial connector’s shortcut text and change the name of the initial
connector (in the command line) to match the name of the new connector
instance.

Starting the connector

A connector must be explicitly started using its connector start-up script. On
Windows systems the startup script should reside in the connector’s runtime
directory:ProductDir\connectors\connNamewhere connName identifies the connector.

Table 4. Startup scripts for a connector

Operating system Startup script

Windows start_connName .bat

When the startup script runs, it expects by default to find the configuration file in
the Productdir (see the commands below). This is where you place your
configuration file.

Note: You need a local configuration file if the adapter is using JMS transport.
Starting the connector on the Windows system:

* From the Start menu, select Programs>IBM WebSphere Business Integration
Express>Adapters>Connectors. By default, the program name is “IBM
WebSphere Business Integration Server Express”. However, it can be customized.
Alternatively, you can create a desktop shortcut to your connector.

¢ From the Windows command line: start_connName connName brokerName
{-cconfigFile}.

* On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for an
Auto service) or when you start the service through the Windows Services
window (for a Manual service).

Chapter 3. Configuring the adapter 15



Starting the eMatrix adapter

The connector starts when the start_eMatrix.bat or start_eMatrix.sh script is
run. These start files contain two variables that must be set before the adapter will
run. They are:

e EMADK: This must be set to the location of the eMatrix ADK .jar file.

* EM_LIB: This must be set to the path of the directory containing the eMatrix
shared library files.

For example:
set EMADK=c:\ematrix96\java\lib\eMatrixServletRMI.jar
set EM_LIB=c:\ematrix96\bin\winnt

Note: You do not need to set EM_LIB if you are running the eMatrix collaboration
server on a separate machine and you have installed the stand-alone
eMatrix ADK .jar file on it.

Stopping the connector

The way to stop a connector depends on the way that the connector was started.

Windows:
* You can invoke the startup script which creates a separate “console” window for

“u_

the connector. In this window, type “q” and press Enter to stop the connector.

* You can configure the connector to start as a Windows service. In this case, the
connector stops when the Windows system shuts down.

Using log and trace files

The adapter components provide several levels of message logging and tracing.

The connector uses the adapter framework to log error, informational and trace
messages. Error and informational messages are recorded in an external log file,
and the trace messages and trace level (0 to 5) are recorded in a trace file. The
default message file name is eMatrixConnector.txt.

describes the type of messages logged at each tracing level.

Table 5. Trace file tracing levels

Trace Level Description

0 * Logs errors and fatal errors from the eMatrix ODA
* Logs warnings that require a system administrator’s attention

¢ Logs important messages from the application

Traces all entering and exiting messages for method

Traces the ODA’s properties and their values

Traces the names of all business objects

Traces business object properties and the values received

Q| W || -

¢ Indicates the ODA initialization values for all of its properties

* Traces the business object definition dump
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You configure both the log and trace files names, as well as the trace level, in
Connector Configurator Express. Refer to|[Appendix B, “Connector Configurator|
[Express,” on page 65| for details.

The ODA has no logging capability; error messages are sent directly to the user
interface. Trace files and the trace level are configured in Business Object Designer
Express. The process is described inl”Conﬁgure the agent” on page 33.| The ODA
trace levels are the same as the connector trace levels, shown in [Table 5 on page 16|
above.

For more details on error handling and troubleshooting, refer to
[“Troubleshooting and error handling,” on page 39,
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Chapter 4. Understanding business objects

This chapter describes the structure of business objects, how the adapter processes
the business objects, and the assumptions the adapter makes about them.

The chapter contains the following sections:

* [“Defining metadata” on page 19|

* [“Overview of business object structure” on page 19|

» [“Business objects for eMatrix” on page 20|

+ [“Generating business objects” on page 29|

Defining metadata

The adapter for eMatrix is metadata-driven. In the WebSphere business integration
system, metadata is defined as application-specific information that describes its
data structures. The metadata is used to construct business object and relationship
definitions that the connector uses at run time to build business objects.

A metadata-driven adapter handles each business object that it supports according
to the metadata encoded in the business object definition. This enables the adapter
to handle new or modified business object definitions without requiring
modifications to the code. You can make changes to the business object definitions
by editing them in Business Object Designer Express.

Application-specific metadata may represent business object types, relationships,
their properties, or attributes. Actual data values for each business object are
conveyed at run time. The data values are encapsulated in the business objects that
are passed between adapter and broker.

The adapter makes assumptions about the structure of its supported business
objects, the relationships between parent and child business objects, and the format
of the data. Therefore, it is important that the structure of the business object
exactly match the structure defined for the corresponding object within eMatrix or
the adapter will not be able to process business objects correctly.

Note: If you need to make changes to the business object structure, IBM
recommends that you make them to the corresponding object in eMatrix,

using the ODA. Refer to|[Chapter 5, “Generating business object definitions,”]
for details.

For more information on modifying business object definitions, see the Business
Object Development Guide.

Overview of business object structure

In the WebSphere business integration system, a business object definition consists
of:

* A type name

* Supported verbs

* Attributes

* Application-specific information (ASI)
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An application-specific business object definition is a particular type of a business
object definition. It reflects a specific application’s data structure and attribute
properties.

Some attributes, instead of containing data, point to child business objects or
arrays of child business objects. For instance, attributes may reference child
business objects that represent relationships.

Business objects for adapters can be flat or hierarchical. A flat business object only
contains simple attributes, that is, attributes that represent a single value (such as a
string) and do not point to child business objects. A hierarchical business object
contains both simple attributes and child business objects or arrays of child
business objects.

Hierarchical business objects can contain child business objects that have single or
multiple cardinality. The child objects are stored in their parents” attributes.
Attributes that contain child business objects with multiple cardinality are arrays of
business objects. Attributes that represent child business objects with single
cardinality contain only one such object.

Business objects for eMatrix

Valid application-specific business objects in the WebSphere Business Integration
Server Express system model the essential components of the eMatrix system. The
following eMatrix components can be modelled as business objects:

* Business object types:
Used to organize information. Instances of business objects store information.

* Relationships: Defines a relationship between two business objects

¢ Commands:
Used to perform custom operations or invoke eMatrix programs

A business object definition specifies the components it represents in the
ematrix_class value of its application-specific information (ASI), defined at the
business object level. The three valid ematrix_class values, corresponding to the
eMatrix components listed above, are discussed in the next section.

Business object types

eMatrix business object types are represented in the WebSphere Business
Integration Server Express system by business object definitions with business
object-level ASI that specify an ematrix_class with the value of business_object.
The ASI must also contain an object_type parameter that specifies the name of the
eMatrix business object type that this particular business object will model. For
example:

ematrix_class=business object; object type=<name of eMatrix business object type>

The eMatrix business object types, and hence their business object definitions in
the system, contain two sets of fields. They are:

* Properties, which are fixed and shared by all eMatrix business object types. They
include business object owner, policy and revision.

* Attributes, which are defined by the user (not to be confused with WebSphere
Business Integration Server Express system attributes).

The eMatrix properties available to you through the business object are listed in
[Table 6 on page 21|.
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Note: Use an attribute of type “String” to represent a date. For supported date
formats, refer to the eMatrix documentation.

Table 6. eMatrix business object properties

Property Description Expected attribute type
object_id Unique ID for eMatrix object String
Name Name of eMatrix object String
Revision eMatrix object revision number String
Policy The governing policy for the eMatrix object String
Owner The owner of the eMatrix object String
State The current state of the eMatrix object String
Vault The eMatrix vault that contains this object String
to_relationship One or more “to” eMatrix relationships that this Child object modeling an
object supports eMatrix relationship
Cardinality = 1..n
from_relationship One or more “from” eMatrix relationships that this | Child object modeling an
object supports eMatrix relationship
Cardinality = 1..n

eMatrix lets the user identify objects either through an object ID or through a
combination of type, name and revision. Therefore, all business objects must
contain either:

* An attribute that maps to the property object_id, or

¢ Two attributes, mapping to the properties name and revision, respectively.

These will be key values in the business object definition. For illustrations, refer to

[“Business object definition examples” on page 21|

To specify that a particular business object attribute should be mapped to an
eMatrix attribute:

1. Define the attribute as a simple type, such as a string or integer
2. Include
attr=<eMatrix attribute name>

in the business object definition attribute-level ASI.

Business object definition examples

[Table 7 on page 21| shows a business object definition that includes two
user-defined eMatrix attributes, PartNumber and Size, and maps to the ASI
property object_id.

Table 7. Business object definition #1

Application-specific
Attribute name Type Default value information IsKey?
Objectld String prop=object_id Yes
State String prop=state No
PartNumber String ASX31 attr=PartNumber No
Size Integer 15 attr=Size No

Chapter 4. Understanding business objects
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[Table 8 on page 22khows the same business object definition, but it now maps to
the eMatrix properties, name and revision.

Table 8. Business object definition #2

Application-specific
Attribute name Type Default value information IsKey?
Name String AllSeasonX31 prop=name Yes
Revision String 1 prop=revision Yes
State String prop=state No
PartNumber String ASX31 attr=PartNumber No
Size Integer 15 attr=Size No
Relationships

eMatrix relationships are represented in the WebSphere Business Integration Server
Express system by business object definitions with business object-level ASI that
specify an ematrix_class with the value of relationship. The ASI must also
contain an object_type parameter that specifies the name of the eMatrix
relationship that this particular business object will model. For example:

ematrix_class=relationship; object_type=<name of eMatrix relationship type>

Like the business object definitions described above, the business object definitions
that reflect eMatrix relationships may contain a combination of eMatrix properties
(fixed) and attributes (user-defined).

[Table 9 on page 22| lists the relationship properties.

Table 9. eMatrix relationship object properties

Property Description Expected attribute type
relationship_id Unique ID for eMatrix relationship String
to_object eMatrix object to which this relationship extends Child object modeling an

eMatrix business object
Cardinality = 1

from_object

eMatrix object from which this relationship extends |[Child object modeling an
eMatrix business object
Cardinality = 1

All relationship business object definitions must contain:
e An attribute that maps to the property relationship_id
* Instances ofto_object or from_object attributes (see Note below)

* Attributes with application-specific information categorizing them as to_object
or from_object child business object containers.

Note: A relationship object may contain many instances of the to_object
or from_object attribute, as a single relationship can support many object
types. However, if the relationship is defined as a to_relationship in the
parent business object, then the relationship object may contain only
to_object identifiers. Likewise, if a from_relationship is defined in the
parent business object, the relationship object may contain only from_object
identifiers.

The relationship definition takes this form:
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--Business_Object A
| -- to_relationship = Relationship A to B
| -- to_object = Business_Object B

or

--Business_Object A
| -- from_relationship = Relationship_A_to B
| -- from object = Business Object B

See [“Relationship examples” on page 23| for an illustration.

Defining relationships

The adapter can only recognize relationships between different objects if you
define these relationships explicitly in the business object definition. When
business objects are related, the adapter requires a relationship object to connect
the business objects. If business objects are not connected by a relationship object,
they are assumed to be unrelated.

For example, if you define this business object:

--Business_Object A
| -- to_relationship = Relationship_A_to B
| -- to_object = Business_Object B

and then perform a Retrieve on the parent business object (object A), the adapter
will retrieve A and only those objects of type B that are related to A through the
A-to-B relationship.

However, if you define this business object:

--Business_Object_D
| -- Business_Object E

and then perform a Retrieve on the parent business object (object D), the adapter
will retrieve D and objects of type E regardless of whether they are related to D. In
this case, business object E must have attributes containing valid search criteria, or
you will get an error.

You can combine related and unrelated business objects in a definition, depending
on the business scenario and relationships. For example, you can define this
business object:
--Business_Object_A
| -- to_relationship = Relationship A to B
| -- to_object = Business_Object B
| -- Business_Object D

Here, business objects A and B are related to each other, but business object D is
not related to either of them.

Relationship examples

The two examples shown below are related in the same way, though the
relationship is defined differently in each business object definition.
--Car

| -- to_relationship = CarToTireRelationship
| -- to_object = Tire

--Tire
| -- from_relationship
| -- from object

CarToTireRelationship
Car
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Command objects

eMatrix commands are represented in the WebSphere Business Integration Server
Express system by business object definitions with business object-level ASI that
specify an ematrix_class with the value of command. For example:
ematrix_class=command

Command business object definitions are structured as follows:

=
General ] Aftributes I
Pog MName Type Key Application Specific Information
1 1 B input ehatriz_command_input [T |type=input
2 3 M output eMstrix_ematrix r type=output; dh_mo=eMatrix_DataHandler Default; dh_mimetype
=texdSsml
3 |3 durmimy _key String Ivd
4 |4 |ObjectEvertd String
5 5 r

<

Figure 3. Structure of command business object definitions

The command object has two attributes: one representing the command’s input
and the other representing the command’s output. The input attribute is required
and must be an object. The output attribute is optional and may be either a String
or an object. Both the input and output attributes are identified by the
corresponding attribute level ASI; either type=input or type=output.

The input object contains the command string that will be executed as well as
several variables whose values will be interpolated into the command. The
command string is stored in the input object’s business object level ASI and is
identified by the command= prefix. The following screenshots show an input object,
including the command and input variables.
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= whi_input:Local Project =1ol x|
General I Aftributes ]

Buzineszz Object Level Application-specific information:

|-:c-mmand=ex|:-and bus Ztupek Xname® Xrevision® Zwhere® Xaelect?

Supported Yerbs:

Mame i A pplication-specific information

Create
Delete
Retrieve

Update

| =] wa| ra] =

Figure 4. Input object commands

Notice that this screenshot includes the expand bus command. The attributes of the
input object represent the variables which will be interpolated into this command
string before being sent to the MQL interpreter (shown in .

= whi_input:Local Project =10 x|
General | Aftriutes|
Po= Marme Type Key |Foreign [Requi |Carding Maximu | Default Application
T N type String r r r 255
2 |z name String - - - 255
3|3 reision String - - - 255
4 |4 where String - - - 255
2 |5 |select String r r r 255
& |5 durmimy _key String Ird - - 255 1
7 |7 |OhbjectEventid String
g s r r r 255
“| | i

Figure 5. Input object attributes

The output attribute may be either a string or a business object. When the output
attribute of the business object is a string, it will contain the text returned by the
command. Whe the output attribute is an object, the results of the command will
be passed through a data handler and then translated into a business object
hierarchy. In this case, the output attribute of the command object must contain
information that will invoke the data handler. The following fields may be added
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to the ASI of the output attribute:

Table 10. Asi output attributes

ASI output attribute

Description

dh_mo

Specifies the data handler meta-object name

dh_mimetype

Specifies the mime-type content that is
passed to the data handler

dh_cTassname

Specifies the fully qualified data handler
Java class name

The following screenshots show an example of an output attribute and its
corresponding output object. These screenshots are not related to the input object
screenshots found above.

RI=TEY
General ] Attributes I
Pog MName Type Key Application Specific Information
1 1 B input ehatriz_command_input [T |type=input
3 M output eMstrix_ematrix r 'r:tyge;;:nrtlpm;dh_mn=eMatrix_DataHandler_Defaurt;dh_mimetvpe
3 |3 |dummy_key String =
4 |4 |ObjectEvertd String
r

<

I ol

Figure 6. Command object

Note: The output attribute is identified inby the attribute level ASI

type=output. Also, the ASI contains additional information to identify and

invoke the XML data handler.

command object.
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= eMatrix_ematrix:Local Project 18] x|
Pos Mame Type ey [Foreign  [Requi Cardina Maximy | Default Application Specific

LI instruction String r - r 255 ml type=pi

2 12 daoctype Strirg - - - 255 type=doctyne

I BILG ehdatriz_TLO_emstrix I |l - 1 ematrixtype=podats

34 atinnProperties;types=
34 B crestionProperties |ehdstrix_crestionProperties | [ Il Il 1 ;rc:fﬂatl;n R

311314 releaze String I - [ 255 releaze;type=podata

310312 datetime String ™ r |l 255 datetime;type=podats

310313 event String - Il Il 255 eventtype=pcdata

310314 dtelinfo String r r |l 255 dtelinfo;type=pedata

310315 ObjectEvertld | String

32 |33 OhjectEventld String

4 |4 |ObjectEventd String

3 |5 r r r 255

ull | i

Figure 7. A business object hierarchy assigned to capture the command output

Note: The business hierarchy shown above represents a imple XML DTD that wil

encapsulate the output of an MQL command.

Note: The only verb supported for command business objects is Create.

Business object verbs

Every business object contains a verb, which describes how the data in the
application-specific business object should be handled by the eMatrix adapter.

The adapter identifies a business object using either its unique objectld or a
combination of type, name and revision. These are all user-defined properties. For
details, see [“Business object types” on page 20}

The adapter interprets the same verb differently for different classes of eMatrix
objects. It checks the value of ematrix_class in the business object definition before
processing the business object.

[Table 11 on page 27 lists the business object verbs available to the adapter for

eMatrix and describes the actions that the adapter performs with each one.

Table 11. Business object verbs and actions

Verb

eMatrix class

Action

Create

Business objects

Creates one or more new business objects in eMatrix, along with
any relationships. Uses name, type and revision specified in the request.
Uses vault and policy values if specified, otherwise uses the default.

Creates any specified child objects and relationships.

Relationships Cannot create relationships independently, because all child objects must
have the same verb as the parent object. To create a new relationship
between objects with an already existing relationship, use Update.

Commands Executes the command in the eMatrix system and returns any results to

the request object.
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Table 11. Business object verbs and actions (continued)

Verb eMatrix class Action
Update Business objects Updates one or more specified business objects and their relationships.
and relationships For an example, see below.
Delete Business objects Deletes the specified business object and automatically deletes any
relationships bound to it. All deletes are physical deletes.
Relationships Deletes the relationship denoted by the relationship ID. Disconnects the
business objects bound to the relationship; does not delete them.
Retrieve Business objects Retrieves the entire business object from eMatrix, including relationships
and relationships and any eMatrix business objects that correspond to attributes in the

business object.

The business object returned to the integration broker should accurately
reflect the structure in the business object definition.

RetrieveBy | Business objects Retrieves the entire business object from eMatrix, using key and/or
Content and relationships non-key information. If it finds more than one match, it returns the
first one and sends a message saying “Multiple hits”.

Exists Business objects Verifies whether the top-level business object exists in eMatrix.
and relationships

The verb is contained within the application-specific business object. Its value is set
by the broker that creates the business object. The adapter will perform different
operations on the eMatrix application, depending on the verb and the contents of
the business object.

Once the adapter has processed the business object, and invoked the requisite
actions in the eMatrix system, it returns a status code. It may also return a new
business object containing information about the state of the application to the
integration broker.

Attribute properties

The business object definitions have various properties that you can set on their
business object attributes. The tables below list the attributes and their values.

lists simple attributes.

Table 12. Simple attributes

Attribute Property

Name Specifies the business object field name.

Type Specifies the business object field type.

MaxLength 255 by default.

IsKey Each business object must have at least one key attribute, which you specify
by setting the key property to true for an attribute.

IsForeighKey Not used.

Is Required Not used.

AppSpecInfo Stores the application-specific information (ASI), such as attr=<attribute name>.

DefaultValue Specifies a default value that the connector uses for a simple attribute in

the inbound business object if the attribute is not set and is
a required attribute.
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Application-specific information

Application-specific information (ASI) provides the connector with
application-dependent instructions on how to process business objects. If you
extend or modify a business object definition, you must make sure that the
application-specific information in the definition matches the syntax that the
connector expects.

Application-specific information can be specified on the business object, on each
business object attribute, and for each verb. For simple attributes, the ASI specifies
either the type of the eMatrix attribute or the name of the eMatrix property (such
as name, revision, or vault). For child business objects, the ASI specifies the
direction of the relationship (for object hierarchies representing eMatrix business
objects and relationships).

Generating business objects

Business Object Designer Express provides a graphical interface that enables you to
ogenerate business object definitions for use at run time. For details, see

[“Generating business object definitions,” on page 31|

If the object model in eMatrix is changed, use the ODA in Business Object
Designer Express to modify the original business object definition to reflect the
update, or to create a new definition.

Chapter 4. Understanding business objects 29



30 Adapter for eMatrix User Guide



Chapter 5. Generating business object definitions

This chapter describes the Object Discovery Agent (ODA) for eMatrix, and how to
use it to generate business object definitions for the adapter for eMatrix.

This chapter contains the following sections:

+ [“Overview of the ODA for eMatrix” on page 31|

* [“Generating business object definitions” on page 31|

» [“Uploading your files” on page 38|

Overview of the ODA for eMatrix

An ODA (Object Discovery Agent) enables you to generate application-specific
business object definitions. A business object definition is a template for a business
object. The ODA examines specified application objects, “discovers” the elements
of those objects that correspond to business object attributes, and generates
business object definitions to represent the information. Business Object Designer
Express provides a graphical interface to access the Object Discovery Agent and to
work with it interactively.

The Object Discovery Agent (ODA) for eMatrix supports both business object and
relationship types. The ODA connects to the eMatrix database using the
initialization properties that you provide in Business Object Designer Express.

It then retrieves all the business object type names from the eMatrix database and
presents them in Business Object Designer Express. You can expand any of the
business object types to see the relationships associated with them, and you can
also expand these relationships. You can then select one or more of these business
object types (parent or child) and relationship types and generate a business object
definition for it.

The Business Object Designer Express wizard automates the process of creating
these definitions, using the eMatrix business object attributes retrieved by the
ODA. Business object definitions created for child business object and relationship
types are associated with the parent business object definition. You can view or
make modifications to a business object definition before you save it to the server.

You use the ODA to generate business object definitions at two different stages:

1. When the system is first set up: You must create a set of business object
definitions for all the events defined within eMatrix.

2. Whenever an object or relationship type used in an event is modified in
eMatrix: You must run the ODA in Business Object Designer Express to pick
up the changed metadata for the object and export a new business object
definition to the broker repository.

Generating business object definitions

This section describes how to use eMatrix ODA in Business Object Designer
Express to generate business object definitions. For detailed information on
launching and using Business Object Designer Express, see the Business Object
Development Guide.
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Before you begin

The eMatrix RMI collaboration server must be installed before you can run the
eMatrix ODA. Once the collaboration server is installed, you must run the RMI
daemon for the ODA to connect to the server.

You can run the ODA and the server on different machines. If you do, you need to
know the hostname, port and name of the collaboration server on the remote
machine.

Regardless of whether your ODA and collaboration server are run on different
machines, verify that the RMI server and ODA connection string are running on
the same port. To do this, follow either of these suggestions:

* Go to the server installation directory eMatrix\bin\winnt and double-click the
rmireg.bat file. This will start the RMI server and display the port number in a
pop-up window.

* Go to the framework.properties file in the
RMIServerInstallationDir\java\properties directory and examine the
ematirx.server.host property. This property lists both the hostname and the
port.

Starting the ODA

The ODA for eMatrix has a default name of eMatrix0DA. The name can be changed
by changing the value of the AGENTNAME variable in the start script.

¢ To start the ODA from Windows, select:

Start>Programs>IBM WebSphere Business Integration Adapters
Adapters>Object Discovery Agent>eMatrix Object Discovery Agent

e To start the ODA from the command line, run this command:
start_eMatrixODA

Running Business Object Designer Express

Business Object Designer Express provides a wizard that guides you through the
steps to generate a business object definition using the ODA. The steps are as
follows:

Start Business Object Designer Express
To run Business Object Designer Express from Windows:

1. Select Start>Programs>IBM WebSphere Business Integration Express
Adapters>
Tools>Business Object Designer Express

2. The Business Object Designer Express main window opens.

3. To choose an ODA, Select File > New Using ODA. The Business Object Wizard -
Step 1 of 6 - Select Agent screen appears (see |Figure 8 on page 33[).
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=10l x|

Business Object Wizard - Step

Press "Find Agentz" to locate DDAs Located agents:
in your subrnet [3.26.237 xx=]. You i
will be given an estimate af the time Ebd atrix004 [mahalze: 57037]

required to complate the operation
and a means bo cancel the search,

If wou have an ODA that iz running
oh & machine outzide subnet

9 26. 237w press ""Configure
Digcoven' to include that maching
in the zearch.

Configure Discovery |
Find Agents |

4] |

Agent's name: Ebd atrix0 DA,

Agent'z hozt: Imahalse

Port: |5?D4‘I

< Back | MHest > Cancel

Figure 8. Select Agent screen

4. Click Find Agents. The system finds ODAs running on your system, including
eMatrix0DA, and lists them in the Located agents: window.

5. Select eMatrix0DA and select Next.

Configure the agent
The Business Object Wizard - Step 2 of 6 - Configure Agent screen appears.

In this screen you enter the information that the ODA needs to establish a context
to communicate with the eMatrix database. The required properties and their
values are shown in [Table 13 on page 34}
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Business Object Wizard - Step 2 of 6 - Configure Agent - |EI|£|
— Profiles
Current profile: | j
Save | e | Eemove |
Property Value Type Description
1 Contextlzer mahalse String User name to establish a connection to Ebal
2 ContextPassword  |test String Pazsword to be used with user name to est
3 Hosthame mahalze String Mame and Port of the machine running the el
4 Collaborationsetver| CiebatrixSeryer String Mame of the etatrix Collaborstion Server.
5 DefautBOPrefix Ehdatriz String The default business object prefix to be use
B TraceFileMame EMdatrizODAtrace txd String Mame of the trace file.
7 Tracelewvel ] Integer Trace level for the agent.
g lezzageFile EtdatrizODALgent Tt String Mame of the error and message file
| | i
< Back I Mest = I Cancel |

Figure 9. Configure Agent screen

1. Use the Profiles menu to create a new profile. You may also select an existing
profile.

2. Type the name of each property, its value, type and description.

Note: If you use a profile, the property values are filled in for you.

Table 13. Property values for configuring the ODA

Property name Property type |Default value Description Required

ContextUser String Creator The user name that is used to Yes
establish a context object to connect
to the eMatrix database.

ContextPassword String None The password that is used to establish Yes
a context object to connect to the
eMatrix database. May be left empty.

HostName String The host name and port for the Yes
eMatrix collaboration server.
For example; katari:1099

DefaultBOPrefix String EMatrix The default prefix for the business Nos
object definition.
TraceFileName String <agentname> The name of the trace file. No
Trace.txt
TraceLevel Integer 5 Trace level enabled for the ODA. Yes
MessageFile String <agentname> The name of the error and message file. Yes
Agent.txt

All messages displayed by the eMatrix ODA appear in the eMatrix0DAAgent.txt
file, which has a standard message file format.
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Note: If the name of the message file is not correctly specified, the ODA will run
without messages.

Creating a Profile

You can also can save all the values you enter on this screen to a profile. Instead of
re-typing all the data the next time you run the ODA, you simply select a profile
from the drop-down menu and use the saved values.

You can save multiple profiles, each with a different set of specified values for the
same properties.

When you have finished, click Next.

Select a business object

The Business Object Wizard - Step 3 of 6 - Select Source screen appears. Use this
screen to select any number of business object or relationship types for which the
ODA will generate business object definitions.

The screen lists the types that have been defined in eMatrix. If eMatrix has not
been initialized, the list will be empty.

Business Object Wizard - Step 3 of 6 - Select Source o ] [

From the tree below, select the source nodes from which the Designer will generate Business

Objects. Click "Mest' to continue. Use this abject instead

Mame Ciescription =
=l TestObjectType Business Type
- RelationshipTypes Relationships
[+ DenivedObject Busziness Type
- Object_A Busziness Type
- Object_B Business Type
|- Object_C Business T
_[_]. Business Type
= RelationshipTypes R elationships
- Tire2¥ehicleRelationship Relationship Type
= FromObiects Related Objects
o Tipe Business Type o
- Car25 eatR elationship Relationship Type
=1 ToObjects Felated Objects
o Gaat Busziness Type
El-- Car2DoorR elationship Relationship Type
=l ToObjects Felated Objects
- Door Business Type
- Tire Business Type -
< Back Mext > | Cancel |

Figure 10. Select Source screen

¢ Expand a parent business object to see a list of its relationship types.

* Expand a relationship type to see a list of the business objects to or from which
it extends.

1. Select the business object types you want to use.
2. Click Next.
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Confirm selection

The Business Object Wizard - Step 4 of 6 - Confirm source nodes for business object
definitions screen appears. It shows the source nodes you selected.

Business Object Wizard - Step 4 of 6 - Confirm source node: =1 x]|

otz]

Business objects are about to be generated using the source nodes summarnized below. Click
"Mext" to start generating the objects or click "Back" to change your zelection.

Mame I Dezcription

ICar | Business Type

< Back I hleut I Cancel

Figure 11. Confirm source nodes screen

Click Back to make changes or Next to confirm the list is correct.

+ BD Properties 5'

Property Value Type Description
1 Prefix Ebdatriz String Prefix to he added to each Buzinezs O
2 “erhs - | String “Werbs applicable to all selected objects
v
WIRetrieve
[w|Delete
[w|Update
[WIRetrieveBry Conterit
dl i

0K |

Figure 12. Generating business objects screen
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The next screen requires you to set the business object properties. Here you can
select the business object prefix and the verb or verbs that the business objects will

use. Deselect any of the verb values that you do not want your business objects to
use.

Click OK to move on.

Save the business object definition
The Business Object Wizard - Step 6 of 6 - Save business objects screen appears.

Business Object Wizard - Step 6 of 6 - Save busine o ] o4 |
ete]

Buzness objects were successfully created. You can save their definition to the server
now o do it later if pou wizh ta inzpect themn first,

Save to praject: | test? ﬂ
[~ Save a copy of the business objects to a separate file

¥ Open the new BOs in separate windows

[™ Shutdown OD& EMatiz0D&

¢ Back I Finish I Cancel

Figure 13. Save business objects screen

Here you choose the location to which your business object definition will be
saved.

You can optionally save the generated business object definitions to a file. To do so:
1. Check Save business objects to a file. A dialog box appears.

2. Type the location in which you want the copy of the new business object
definitions to be saved.

Business Object Designer Express saves the files to the specified location.

Note: If you create new custom objects in eMatrix, you must add new business
object definitions for them, using the ODA as described in this chapter.

If you have finished working with the ODA, you can shut it down by checking
Shutdown ODA: eMatrix ODA before clicking Finish.
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Uploading your files

The newly created business object definition files must be uploaded to the
integration broker once they have been created.

ForInterChange Server Express, if you have saved your business object definition

files to a local machine and need to upload them to the repository on the server,
refer to the System Implementation Guide.

38 Adapter for eMatrix User Guide



Chapter 6. Troubleshooting and error handling

This chapter describes how the adapter handles some common errors and offers
advice on troubleshooting common problems.

This chapter covers:

* [“Processing errors” on page 39

+ [“Troubleshooting” on page 40|

Processing errors

In general, whenever the adapter encounters an error, it logs an error message
through the connector API.

All error messages are stored in an external message file, as described in
llog and trace files” on page 16.

For all operations, if a connection cannot be established to eMatrix or if the
connection is lost during processing, the adapter returns the code
APPRESPONSETIMEOUT and logs a fatal error. This causes the connector to be
terminated and an e-mail notification is sent to the administrator.

Unresolved events

The adapter takes action to recover from unresolved or incomplete events
depending on the value of the configuration property s.

The options are listed in|Table 14

Table 14. Processing in-doubt events

Value of “inDoubtEvents” Action to take

FailOnStartUp Log a fatal error and terminate.

Reprocess Publish the event to the broker like a normal event.
LogError Ignore the event and log an error.

Ignore Ignore the event.

Polling errors

Several errors may occur in the polling process. The most common are listed in

[fable 13

Table 15. Processing polling errors

Error

Action

Cannot publish event because it is not subscribed. |Logs an error message, may archive the event, and

continues processing events.

Cannot publish event because connector Sets event status to 0 and returns SUCCESS code.
controller is not active.

Error is specific to this event, for example, Logs an error message, may archive the event, and
invalid value specified in event. continues processing events.

© Copyright IBM Corp. 2004, 2005

39



Table 15. Processing polling errors (continued)

Error Action

Broker rejects event with an error message. Logs an error message, may archive the event and the error
message, and returns FAIL code.

Cannot communicate with eMatrix; other Logs a fatal error messages and returns

unrecoverable errors APPRESPONSETIMEOUT code

Verb processing errors

The adapter requires a unique business object ID or combination of values (type,
name and revision) to identify a business object. If the values that are supplied are
incorrect or do not match any existing business object, an error is reported.

These are some of the most common verb processing errors.

* When creating business objects, if the adapter is successful, it posts the newly
created business object to the integration broker and returns the value
SUCCEED.

If a business object with the specified values already exists, the adapter returns
VALDUPES and does not create the new business object.

¢ When updating business objects, if the adapter is successful, it posts the newly
updated business object to the integration broker and returns the value
VALCHANGE.

* If any error occurs during processing, the adapter returns the FAIL code to the
broker, and logs an explanatory error message.

Troubleshooting

This sections describes some simple troubleshooting techniques for common
problems you may encounter when using the adapter for eMatrix.

Event notification

This section describes four common problems that may arise during event
notification. They are:

 Faulty event generation

* Incorrect eMatrix event business object names
* The event vault not found

* Incorrect business object hierarchies

Checking for event generation
When you debug the event notification functionality, you will first want to check
whether you are successfully generating any events. To do this:

1. Perform an action that you know will invoke a trigger which calls
WBIEventLogger.

2. Next, perform a query to see if the event was generated; for example:
temp query bus wbi_Event #*;

3. If no events are being generated, make sure you have installed a trigger that
will invoke WBIEventLogger.
You can check whether a trigger was installed by opening up the appropriate
business object type or relationship definition in the eMatrix Business Modeler.
See|Appendix C, “Sample scenario,” on page 81|for an example of how to
install an event notification trigger.
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Note: No events are generated when the user name of the user whose actions
invoke the trigger matches the adapterUser constant specified in
WBIEventLogger. The adapterUser constant specifies the user name that
the adapter should be using to log in to the eMatrix system.

The point of ignoring such events is to prevent situations where the
adapter modifies an entity in the eMatrix system and thereby causes an
event to be logged. We assume that the adapter is aware of its own
activities and does not need to log them. Keep this in mind when
testing.
4. If you wish to test whether a trigger that executes WBIEventLogger is being
invoked, set the following property in the matrix.ini file:

MX_MQL_TRACE=TRUE

When you perform an action which invokes the trigger you'll see a message
similar to this:

18:15:00.826 MQL t@2900 Session: mx3f20221364f87ac7

18:15:00.826 MQL tG2900 Program: WBIEventLogger

18:15:00.826 MQL t@2900 args: -method recordEvent ${OBJECTID} n=wbi_cpu
v=Update p=1

18:15:08.417 MQL t@2900 End Program:MQL<3>

This tells you that the trigger has executed WBIEventLogger with the
arguments listed above.

Checking eMatrix event business object names

If you know that events are being generated, but you still get an error every time
you poll the eMatrix application, take a closer look at the name of the event
business object. The business object name should look something like this:

wbi_22032.41802.50936.705_1058897313350_1892833611

If you notice upper-case words, such as FROMOBJECT, appearing in business
object names, you may have specified an invalid MARCO value as an argument to
the trigger. To resolve this:

1. Check all business object type definitions in the Business Modeler.

2. Review the triggers they use to invoke WBIEventLogger and make sure any
MARCO values you provide as arguments are correct.

Finding the event vault
If you receive the following error during event polling, it means the adapter cannot
find the EventVault referenced in your connector properties. The error is:

System Error: #1600039: vault 'WBI_Events' does not exist

You may get this error for one of two reasons:
* You are referencing the wrong vault in your properties, or
* You have not created the vault.

Run InstallEventTables to make sure your vault was created, and check the name
of EventVault in the connector properties.

Checking business object hierarchies

When you create a business object hierarchy that will be used for event
notification, make sure the hierarchy does not include any child business object
definitions that represent an eMatrix business object type and whose parent also
represents an eMatrix business object type.

Chapter 6. Troubleshooting and error handling 41



If such an object exists, the adapter will fail when polling and log a message
similar to this:

An error occurred while trying to validate your WBI business object
instance hierarchy.

The reason for this is that business objects which represent eMatrix business objects
cannot contain attributes that also represent eMatrix business objects but are null.

Request processing

This section describes two common problems that may arise during request
processing. They are:

* Incorrect string values in commands

* Incorrect hierarchical business object values

Processing strings in commands

The values of string-typed attributes of business objects representing eMatrix
commands are not quoted when they are interpolated into the command template
prior to command processing. Therefore, an unquoted attribute value containing
white space will be interpreted as two words of an MQL command.

Values in business object hierarchies

When sending a request, you may have child business objects in the hierarchy
representing eMatrix business objects that have parent objects also representing
eMatrix business objects. Make sure that any child business object is not null. The
adapter will throw an error if such a hierarchy is encountered.

General tips
Here are two general problems and their resolution.

Unsupported business objects

You may receive a message like this in your log or trace file:

Unable to find version “*.*.*” of business object definition
“wbi_computer_bundle_to_computer”

To resolve it, you need to add the business object mentioned in the message to the
list of supported business objects in Connector Configurator Express.

Incomplete business object relationships

When you use the ODA, you may wish to model two business object types and
their connecting relationship. Be sure to select all three in a hierarchical fashion as
displayed in [Figure 14 on page 43|
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Business Object Wizard - Step 3 of b - Select Source oy ] |

Fram the tree below, select the source nodes from which the Designer will generate Business

Objects. Click "Mext" to continue. Use e slieet feiead

MHame

Description

bundle Business Type
_L:.| computer Business Type
=1 RelationshipT ypes Relationzhips

i bundle to computer Relationship Type
=l FromObjects Related Objects

s bundie Business Type

[+ computer to pci component Relationship Type
[+ epu Busineszs Type
[+ network card Business Type
- ush 2.0 card Business Type
* sound card Business Type
[+ gound chip Business Type
[+ whi_Ewvent Busineszs Type
[*- whi_Archived_Ewvent Business Type

| 3]
< Back Mext > | Cancel |

Figure 14. Selecting business object relationships

If you do not do this, the ODA will create an incomplete model of the types and
their shared relationship.
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Appendix A. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of WebSphere Business Integration Server Express adapters. The
information covers InterChange Server Express.

For information about properties specific to this connector, see the relevant section
in this guide.

New properties

These standard properties have been added in this release:
* AdapterHelpName

* ControllerEventSequencing

* jms.ListenerConcurrency

* jms.TransportOptimized

¢ TivoliTransactionMonitorPerformance

Standard connector properties overview

Connectors have two types of configuration properties:
 Standard configuration properties, which are used by the framework

* Application, or connector-specific, configuration properties, which are used by
the agent

These properties determine the adapter framework and the agent run-time
behavior.

This section describes how to start Connector Configurator Express and describes
characteristics common to all properties. For information on configuration
properties specific to a connector, see its adapter user guide.

Starting Connector Configurator Express

You configure connector properties from Connector Configurator Express, which
you access from System Manager. For more information on using Connector
Configurator Express, refer to the sections on Connector Configurator Express in
this guide.

Connector Configurator Express and System Manager run only on the Windows
system.

Configuration property values overview
The connector uses the following order to determine a property’s value:
1. Default
2. Repository for InterChange Server Express integration broker.
3. Local configuration file
4. Command line
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The default length of a property field is 255 characters. There is no limit on the
length of a STRING property type. The length of an INTEGER type is determined
by the server on which the adapter is running.

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s update
method determines how the change takes effect.

The update characteristics of a property, that is, how and when a change to the
connector properties takes effect, depend on the nature of the property.

There are four update methods for standard connector properties:

* Dynamic
The new value takes effect immediately after the change is saved in System
Manager. However, if the connector is in stand-alone mode (independently of
System Manager).

* Agent restart (InterChange Server Express only)
The new value takes effect only after you stop and restart the connector agent.

* Component restart
The new value takes effect only after the connector is stopped and then restarted
in System Manager. You do not need to stop and restart the agent or the server
process.

* System restart
The new value takes effect only after you stop and restart the connector agent
and the server.

To determine how a specific property is updated, refer to the Update Method
column in the Connector Configurator Express window, or see the Update Method
column in [Table 16 on page 47}

There are three locations in which a standard property can reside. Some properties
can reside in more than one location.

* ReposController
The property resides in the connector controller and is effective only there. If
you change the value on the agent side, it does not affect the controller.

* ReposAgent
The property resides in the agent and is effective only there. A local
configuration can override this value, depending on the property.

* LocalConfig
The property resides in the configuration file for the connector and can act only
through the configuration file. The controller cannot change the value of the
property, and is not aware of changes made to the configuration file unless the
system is redeployed to update the controller explicitly.

Standard properties quick-reference

[Table 16 on page 47| provides a quick-reference to the standard connector
configuration properties. Not all connectors require all of these properties, and
property settings may differ. .

See the section following the table for a description of each property.
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Note: In the Notes column in [Table 16| the phrase “RepositoryDirectory is set to
<REMOTE>" indicates that the broker is InterChange Server Express.

Table 16. Summary of standard configuration properties

Update
Property name Possible values Default value method Notes
AdapterHelpName One of the valid Template name, if valid, | Component Supported regional
subdirectories in or blank field restart settings.
<ProductDir>\bin\Data\ Include chs_chn,
App\Help that has a valid cht_twn, deu_deu,
<Regional Setting> esn_esp, fra_fra,
directory ita_ita, jpn_jpn,
kor_kor, ptb_bra,
and enu_usa (default).
AdminInQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/ADMININQUEUE restart only when the value
of DeliveryTransport
is JMS
AdminOutQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/ADMINOUTQUEUE restart only when the value
of DeliveryTransport
is JMS
AgentConnections 1 through 4 1 Component This property is valid
restart only when the value
of DeliveryTransport
is MQ or IDL, the value
of Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
AgentTraceLevel 0 through 5 0 Dynamic
for ICS;
otherwise
Component
restart
ApplicationName Application name The value specified for | Component
the connector restart
application name
CharacterEncoding Any supported code. ascii7 Component This property is valid
The list shows this subset: restart only for C++ connectors.
ascii7, ascii8, SJIS,
Cp949, GBK, Big5,
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
CommonEventInfrastruc true or false false Component
ture restart
CommonEventInfrastruc A URL string, for No default value. Component This property is valid
tureURL example, restart only if the value of
corbaloc:iiop: CommonEvent
host:2809. Infrastructure is true.
ConcurrentEventTrig 1 through 32,767 1 Component This property is valid
geredFlows restart only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is ICS.
ContainerManagedEvents | Blank or JMS Blank Component This property is valid
restart only when the value

of Delivery Transport
is JMS.
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Table 16. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update
method

Notes

ControllerEventSequenc
ing

true or false

true

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

ControllerStoreAndFor
wardMode

true or false

true

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

ControllerTraceLevel

0 through 5

Dynamic

This property is valid
only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is ICS.

DeliveryQueue

Any valid JMS
queue name

<CONNECTORNAME>
/DELIVERYQUEUE

Component
restart

This property is valid
only when the value
of Delivery Transport
is JMS.

DeliveryTransport

IDL or JMS

IDL when the value of
RepositoryDirectory is
<REMOTE>, otherwise
JMS

Component
restart

If the value of
RepositoryDirectory is
not <REMOTE>,

the only valid value for
this property is JMS.

DuplicateEventElimina
tion

true or false

false

Component
restart

This property is valid
only if the value of
DeliveryTransport is JMS.

EnableOidForFlowMoni
toring

true or false

false

Component
restart

This property is valid
only if the value of
BrokerType is ICS.

FaultQueue

Any valid queue name.

<CONNECTORNAME>
/FAULTQUEUE

Component
restart

This property is

valid only if the value
of DeliveryTransport
is JMS.

jms.FactoryClassName

CxCommon.Messaging.jms
. IBMMQSeriesFactory,
CxCommon.Messaging
.Jms.SonicMQFactory,
or any Java class name

CxCommon.Messaging.
jms.IBMMQSeriesFactory

Component
restart

This property is

valid only if the value
of DeliveryTransport
is JMS.

jms.ListenerConcurrency

1 through 32767

Component
restart

This property is

valid only if the value of
jms.TransportOptimized
is true.

jms.MessageBrokerName

If the value of
jms.FactoryClassName
is IBM, use
crossworlds.queue.
manager.

crossworlds.queue.
manager

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS

jms.NumConcurrent
Requests

Positive integer

10

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS
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Table 16. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
jms.Password Any valid password Component This property is valid
restart only if the value of
DeliveryTransport
is JMS
jms.TransportOptimized true or false false Component This property is valid
restart only if the value of
DeliveryTransport
is JMS and the value of
BrokerType is ICS.
jms.UserName Any valid name Component This property is valid
restart only if the value of
Delivery Transport is JMS.
JvmMaxHeapSize Heap size in megabytes 128m Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
JvmMaxNativeStackSize Size of stack in kilobytes 128k Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
JvmMinHeapSize Heap size in megabytes Im Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
ListenerConcurrency 1 through 100 1 Component This property is valid
restart only if the value of
DeliveryTransport is MQ.
Locale This is a subset of the en_US Component
supported locales: restart
en_US, ja_JP, ko KR,
zh_CN, zh_TW, fr_FR,
de DE, it_IT,
es_ES, pt_BR
LogAtInterchangeEnd true or false false Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
MaxEventCapacity 1 through 2147483647 2147483647 Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
MessageFileName Valid file name InterchangeSystem.txt Component
restart
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Table 16. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
MonitorQueue Any valid queue name <CONNECTORNAME> Component This property is valid
/MONITORQUEUE restart only if the value of
DuplicateEventElimination
is true and
ContainerManagedEvents
has no value.
OADAutoRestartAgent true or false false Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
OADMaxNumRetry A positive integer 1000 Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
OADRetryTimelnterval A positive integer 10 Dynamic This property is valid
in minutes only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
PollEndTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
PollFrequency A positive integer 10000 Dynamic
(in milliseconds) if broker is
ICS;
otherwise
Component
restart
PollQuantity 1 through 500 1 Agent restart | This property is valid
only if the value of
ContainerManagedEvents
is JMS.
PollStartTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
RepositoryDirectory <REMOTE> if the broker |For ICS, the value is set | Agent restart
is ICS; otherwise any to <REMOTE>
valid local directory.
RequestQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/REQUESTQUEUE restart only if the value of
DeliveryTransport
is JMS
ResponseQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/RESPONSEQUEUE restart only if the value of
DeliveryTransport is JMS.
RestartRetryCount 0 through 99 3 Dynamic
if ICS;
otherwise
Component
restart
RestartRetryInterval A value in minutes 1 Dynamic
from 1 through if ICS;
2147483647 otherwise
Component
restart
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Table 16. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update
method

Notes

RHF2MessageDomain

mrm or xml

mrm

Component
restart

This property is valid
only if the value

of DeliveryTransport

is JMS and the value of
WireFormat is CwXML.

SourceQueue

Any valid WebSphere
MQ queue name

<CONNECTORNAME>
/SOURCEQUEUE

Agent restart

This property is valid
only if the value of
ContainerManagedEvents
is JMS.

SynchronousRequest
Queue

Any valid queue name.

<CONNECTORNAME>
/SYNCHRONOUSREQUEST
QUEUE

Component
restart

This property is valid
only if the value

of DeliveryTransport
is JMS.

SynchronousRequest
Timeout

0 to any number
(milliseconds)

Component
restart

This property is valid
only if the value

of DeliveryTransport
is JMS.

SynchronousResponse
Queue

Any valid queue name

<CONNECTORNAME>
/SYNCHRONOUSRESPONSE
QUEUE

Component
restart

This property is valid
only if the value

of DeliveryTransport
is JMS.

TivoliMonitorTransaction
Performance

true or false

false

Component
restart

WireFormat

CwXML or CwBO

CwXML

Agent restart

The value of this
property must be CwXML
if the value

of RepositoryDirectory

is not set to <REMOTE>.
The value must

be CwBO if the value of
RepositoryDirectory is set
to <REMOTE>.

WsifSynchronousRequest
Timeout

0 to any number
(milliseconds)

Component
restart

This property is not valid
if the value of
BrokerType is ICS.

XMLNameSpaceFormat

short or Tong

short

Agent restart

This property is not valid
if the value of
BrokerType is

ICS.

Standard properties

This section describes the standard connector configuration properties.

AdapterHelpName

The AdapterHelpName property is the name of a directory in which
connector-specific extended help files are located. The directory must be located in
<ProductDir>\bin\Data\ App\Help and must contain at least the language
directory enu_usa. It may contain other directories according to locale.

The default value is the template name if it is valid, or it is blank.

AdmininQueue

The AdminInQueue property specifies the queue that is used by the integration
broker to send administrative messages to the connector.
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The default value is <CONNECTORNAME>/ADMININQUEUE

AdminOutQueue

The AdminOutQueue property specifies the queue that is used by the connector to
send administrative messages to the integration broker.

The default value is <CONNECTORNAME>/ADMINOUTQUEUE

AgentConnections

The AgentConnections property controls the number of ORB (Object Request
Broker) connections opened when the ORB initializes.

The default value of this property is 1.

AgentTraceLevel

The AgentTraceLevel property sets the level of trace messages for the
application-specific component. The connector delivers all trace messages
applicable at the tracing level set and lower.

The default value is 0.

ApplicationName

The ApplicationName property uniquely identifies the name of the connector
application. This name is used by the system administrator to monitor the
integration environment. This property must have a value before you can run the
connector.

The default is the name of the connector.

BrokerType

The BrokerType property identifies the integration broker type that you are using.
The value is ICS, , or .

CharacterEncoding

The CharacterEncoding property specifies the character code set used to map from
a character (such as a letter of the alphabet, a numeric representation, or a
punctuation mark) to a numeric value.

Note: Java-based connectors do not use this property. C++ connectors use the
value ascii7 for this property.

By default, only a subset of supported character encodings is displayed. To add
other supported values to the list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory (<ProductDir>). For
more information, see the Connector Configurator Express appendix in this guide.

ConcurrentEventTriggeredFlows

The ConcurrentEventTriggeredFlows property determines how many business
objects can be concurrently processed by the connector for event delivery. You set
the value of this attribute to the number of business objects that are mapped and
delivered concurrently. For example, if you set the value of this property to 5, five
business objects are processed concurrently.
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Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), the following properties must configured:

* The collaboration must be configured to use multiple threads by setting its
Maximum number of concurrent events property high enough to use multiple
threads.

* The destination application’s application-specific component must be configured
to process requests concurrently.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and is performed serially.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1.

ContainerManagedEvents

The ContainerManagedEvents property allows a JMS-enabled connector with a
JMS event store to provide guaranteed event delivery, in which an event is
removed from the source queue and placed on the destination queue as one JMS
transaction.

When this property is set to JMS, the following properties must also be set to
enable guaranteed event delivery:

¢ PollQuantity = 1 to 500
* SourceQueue = /SOURCEQUEUE

You must also configure a data handler with the MimeType and DHClass (data
handler class) properties. You can also add DataHandlerConfigMOName (the
meta-object name, which is optional). To set those values, use the Data Handler
tab in Connector Configurator Express.

Although these properties are adapter-specific, here are some example values:
* MimeType = text\xml

* DHClass = com.crossworlds.DataHandlers.text.xml

* DataHandlerConfigMOName = MO_DataHandler_Default

The fields for these values in the Data Handler tab are displayed only if you have
set the ContainerManagedEvents property to the value JMS.

Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pollForEvents() method, thereby disabling that method’s functionality.

The ContainerManagedEvents property is valid only if the value of the
DeliveryTransport property is set to JMS.

There is no default value.
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ControllerEventSequencing

The ControllerEventSequencing property enables event sequencing in the connector
controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE> (BrokerType is ICS).

The default value is true.

ControllerStoreAndForwardMode

The ControllerStoreAndForwardMode property sets the behavior of the connector
controller after it detects that the destination application-specific component is
unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches InterChange Server Express (ICS), the connector
controller blocks the request to the application-specific component. When the
application-specific component becomes operational, the controller forwards the
request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific

component is unavailable.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE> (the value of the BrokerType property is ICS).

The default value is true.

ControllerTraceLevel

The ControllerTraceLevel property sets the level of trace messages for the
connector controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE>.

The default value is 0.

DeliveryQueue

The DeliveryQueue property defines the queue that is used by the connector to
send business objects to the integration broker.

This property is valid only if the value of the DeliveryTransport property is set to
JMS.

The default value is <CONNECTORNAME>/DELIVERYQUEUE.
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DeliveryTransport

The DeliveryTransport property specifies the transport mechanism for the delivery
of events. For Java Messaging Service, the value is JMS.

* If the value of the RepositoryDirectory property is set to <REMOTE>, the value
of the DeliveryTransport property can be IDL or JMS, and the default is IDL.

* If the value of the RepositoryDirectory property is a local directory, the value
can be only JMS.

The connector sends service-call requests and administrative messages over
CORBA 1IIOP if the value of the RepositoryDirectory property is IDL.

The default value is JMS.
JMS

The JMS transport mechanism enables communication between the connector and
client connector framework using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as

jms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName
are listed in Connector Configurator Express. The properties

Jjms .MessageBrokerName and jms.FactoryClassName are required for this transport.

There may be a memory limitation if you use the JMS transport mechanism for a
connector in the following environment when InterChange Server Espress (ICS) is
the integration broker.

In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client. If your installation uses less than 768MB of
process heap size, set the following variable and property:

* Set the LDR_CNTRL environment variable in the CWSharedEnv.sh script.
This script is located in the \bin directory below the product directory

(<ProductDir>). Using a text editor, add the following line as the first line in the
CWSharedEnv.sh script:

export LDR_CNTRL=MAXDATA=0x30000000

This line restricts heap memory usage to a maximum of 768 MB (3 segments *
256 MB). If the process memory grows larger than this limit, page swapping can
occur, which can adversely affect the performance of your system.

* Set the value of the IPCCBaseAddress property to 11 or 12. For more
information on this property, see the WebSphere Business Integration Server Express
Installation Guide for Windows..

DuplicateEventElimination

When the value of this property is true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, during
connector development, the connector must have a unique event identifier set as
the business object ObjectEventld attribute in the application-specific code.

Note: When the value of this property is true, the MonitorQueue property must
be enabled to provide guaranteed event delivery.

The default value is false.
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EnableOidForFlowMonitoring

When the value of this property is true, the adapter runtime will mark the
incoming ObjectEventID as a foreign key for flow monitoring.

This property is only valid if the BrokerType property is set to ICS.

The default value is false.

FaultQueue

If the connector experiences an error while processing a message, it moves the
message (and a status indicator and description of the problem) to the queue
specified in the FaultQueue property.

The default value is <CONNECTORNAME>/FAULTQUEUE.

jms.FactoryClassName

The jms.FactoryClassName property specifies the class name to instantiate for a
JMS provider. This property must be set if the value of the DeliveryTransport
property is JMS.

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.

jms.ListenerConcurrency

The jms.ListenerConcurrency property specifies the number of concurrent listeners
for the JMS controller. It specifies the number of threads that fetch and process
messages concurrently within a controller.

This property is valid only if the value of the jms.OptimizedTransport property is
true.

The default value is 1.

jms.MessageBrokerName

The jms.MessageBrokerName specifies the broker name to use for the JMS
provider. You must set this connector property if you specify JMS as the delivery
transport mechanism (in the DeliveryTransport property).

When you connect to a remote message broker, this property requires the following
values:

QueueMgrName : Channel :Hos tName : PortNumber

where:

QueueMgriName is the name of the queue manager.

Channel is the channel used by the client.

HostName is the name of the machine where the queue manager is to reside.
PortNumberis the port number used by the queue manager for listening

For example:
jms .MessageBrokerName = WBIMB.Queue.Manager:CHANNEL1:RemoteMachine:1456

The default value is crossworlds.queue.manager. Use the default when connecting
to a local message broker.
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jms.NumConcurrentRequests

The jms.NumConcurrentRequests property specifies the maximum number of
concurrent service call requests that can be sent to a connector at the same time.
Once that maximum is reached, new service calls are blocked and must wait for
another request to complete before proceeding.

The default value is 10.

jms.Password

The jms.Password property specifies the password for the JMS provider. A value
for this property is optional.

There is no default value.

jms.TransportOptimized

The jms.TransportOptimized property determines if the WIP (work in progress) is
optimized. You must have a WebSphere MQ provider to optimize the WIP. For
optimized WIP to operate, the messaging provider must be able to:

1. Read a message without taking it off the queue

2. Delete a message with a specific ID without transferring the entire message to
the receiver’s memory space

3. Read a message by using a specific ID (needed for recovery purposes)

4. Track the point at which events that have not been read appear.

The JMS APIs cannot be used for optimized WIP because they do not meet
conditions 2 and 4 above, but the MQ Java APIs meet all four conditions, and

hence are required for optimized WIP.

This property is valid only if the value of DeliveryTransport is JMS and the value of
BrokerType is ICS.

The default value is false.

jms.UserName

the jms.UserName property specifies the user name for the J]MS provider. A value
for this property is optional.

There is no default value.

JvmMaxHeapSize

The JvmMaxHeapSize property specifies the maximum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128m.

JvmMaxNativeStackSize

The JvmMaxNativeStackSize property specifies the maximum native stack size for
the agent (in kilobytes).
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This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128k.

JvmMinHeapSize

The JvmMinHeapSize property specifies the minimum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1m.

ListenerConcurrency

The ListenerConcurrency property supports multithreading in WebSphere MQ
Listener when ICS is the integration broker. It enables batch writing of multiple
events to the database, thereby improving system performance.

This property valid only with connectors that use MQ transport. The value of the
DeliveryTransport property must be MQ.

The default value is 1.

Locale

The Locale property specifies the language code, country or territory, and,
optionally, the associated character code set. The value of this property determines
cultural conventions such as collation and sort order of data, date and time
formats, and the symbols used in monetary specifications.

A locale name has the following format:
Ul _TT.codeset

where:

Il is a two-character language code (in lowercase letters)

TT is a two-letter country or territory code (in uppercase letters)

codeset is the name of the associated character code set (may be optional).

By default, only a subset of supported locales are listed. To add other supported
values to the list, you modify the \Data\Std\stdConnProps.xml file in the
<ProductDir>\bin directory. For more information, refer to the Connector
Configurator Express appendix in this guide.

If the connector has not been internationalized, the only valid value for this
property is en_US. To determine whether a specific connector has been globalized,

refer to the user guide for that adapter.

The default value is en_US.

LogAtinterchangeEnd

The LogAtInterchangeEnd property specifies whether to log errors to the log
destination of the integration broker.
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Logging to the log destination also turns on e-mail notification, which generates
e-mail messages for the recipient specified as the value of MESSAGE_RECIPIENT
in the InterchangeSystem.cfg file when errors or fatal errors occur. For example,
when a connector loses its connection to the application, if the value of
LogAtInterChangeEnd is true, an e-mail message is sent to the specified message
recipient.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is false.

MaxEventCapacity

The MaxEventCapacity property specifies maximum number of events in the
controller buffer. This property is used by the flow control feature.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The value can be a positive integer between 1 and 2147483647.

The default value is 2147483647.

MessageFileName

The MessageFileName property specifies the name of the connector message file.
The standard location for the message file is \connectors\messages in the product
directory. Specify the message file name in an absolute path if the message file is
not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a connector has its own message file, see the
individual adapter user guide.

The default value is InterchangeSystem.txt.

MonitorQueue

The MonitorQueue property specifies the logical queue that the connector uses to
monitor duplicate events.

It is valid only if the value of the DeliveryTransport property is JMS and the value
of the DuplicateEventElimination is true.

The default value is <CONNECTORNAME>/MONITORQUEUE

OADAutoRestartAgent

the OADAutoRestartAgent property specifies whether the connector uses the
automatic and remote restart feature. This feature uses the WebSphere
MQ-triggered Object Activation Daemon (OAD) to restart the connector after an
abnormal shutdown, or to start a remote connector from System Monitor.
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This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the WebSphere MQ-triggered OAD
feature. see the WebSphere Business Integration Server Express Installation Guide for
Windows.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is false.

OADMaxNumRetry

The OADMaxNumRetry property specifies the maximum number of times that the
WebSphere MQ-triggered Object Activation Daemon (OAD) automatically attempts
to restart the connector after an abnormal shutdown. The OADAutoRestartAgent
property must be set to true for this property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is 1000.

OADRetryTimelnterval

The OADRetryTimelnterval property specifies the number of minutes in the
retry-time interval for the WebSphere MQ-triggered Object Activation Daemon
(OAD). If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this
property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is 10.

PollEndTime

The PollEndTime property specifies the time to stop polling the event queue. The
format is HH: MM, where HH is 0 through 23 hours, and MM represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
e PollEndTime set and PollStartTime not set

it will poll using the value configured for the PollFrequency property.

PollFrequency

The PollFrequency property specifies the amount of time (in milliseconds) between
the end of one polling action and the start of the next polling action. This is not
the interval between polling actions. Rather, the logic is as follows:
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* Poll to obtain the number of objects specified by the value of the PollQuantity
property.

* Process these objects. For some connectors, this may be partly done on separate
threads, which execute asynchronously to the next polling action.

* Delay for the interval specified by the PollFrequency property.
* Repeat the cycle.

The following values are valid for this property:
¢ The number of milliseconds between polling actions (a positive integer).

* The word no, which causes the connector not to poll. Enter the word in
lowercase.

* The word key, which causes the connector to poll only when you type the letter
p in the connector Command Prompt window. Enter the word in lowercase.

The default is 10000.

Important: Some connectors have restrictions on the use of this property. Where
they exist, these restrictions are documented in the chapter on
installing and configuring the adapter.

PollQuantity

The PollQuantity property designates the number of items from the application
that the connector polls for. If the adapter has a connector-specific property for
setting the poll quantity, the value set in the connector-specific property overrides
the standard property value.

This property is valid only if the value of the DeliveryTransport property is JMS,
and the ContainerManagedEvents property has a value.

An e-mail message is also considered an event. The connector actions are as
follows when it is polled for e-mail.

* When it is polled once, the connector detects the body of the message, which it
reads as an attachment. Since no data handler was specified for this mime type,
it will then ignore the message.

* The connector processes the first BO attachment. The data handler is available
for this MIME type, so it sends the business object to Visual Test Connector.

* When it is polled for the second time, the connector processes the second BO
attachment. The data handler is available for this MIME type, so it sends the
business object to Visual Test Connector.

* Once it is accepted, the third BO attachment should be transmitted.

PollStartTime

The PollStartTime property specifies the time to start polling the event queue. The
format is HH: MM, where HH is O through 23 hours, and MY represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
e PollEndTime set and PollStartTime not set
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it will poll using the value configured for the PollFrequency property.

RepositoryDirectory

The RepositoryDirectory property is the location of the repository from which the
connector reads the XML schema documents that store the metadata for business
object definitions.

If the integration broker is ICS, this value must be set to set to <REMOTE>
because the connector obtains this information from the InterChange Server
Express repository.

When the integration broker is a WebSphere message broker or WAS, this value is
set to <ProductDir>\repository by default. However, it may be set to any valid
directory name.

RequestQueue

The RequestQueue property specifies the queue that is used by the integration
broker to send business objects to the connector.

This property is valid only if the value of the DeliveryTransport property is JMS.

The default value is <CONNECTORNAME>/REQUESTQUEUE.

ResponseQueue

The ResponseQueue property specifies the JMS response queue, which delivers a
response message from the connector framework to the integration broker. When
the integration broker is InterChange Server Express (ICS), the server sends the
request and waits for a response message in the JMS response queue.

This property is valid only if the value of the DeliveryTransport property is JMS.

The default value is <CONNECTORNAME>/RESPONSEQUEUE.

RestartRetryCount

The RestartRetryCount property specifies the number of times the connector
attempts to restart itself. When this property is used for a connector that is
connected in parallel, it specifies the number of times the master connector
application-specific component attempts to restart the client connector
application-specific component.

The default value is 3.

RestartRetryinterval

The RestartRetryInterval property specifies the interval in minutes at which the
connector attempts to restart itself. When this property is used for a connector that
is linked in parallel, it specifies the interval at which the master connector
application-specific component attempts to restart the client connector
application-specific component.

Possible values for the property range from 1 through 2147483647 .

The default value is 1.
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RHF2MessageDomain

The RHF2MessageDomain property allows you to configure the value of the field
domain name in the JMS header. When data is sent to a WebSphere message
broker over JMS transport, the adapter framework writes JMS header information,
with a domain name and a fixed value of mrm. A configurable domain name lets
you track how the WebSphere message broker processes the message data.

This is an example header:

<mcd><Msd>mrm</Msd><Set>3</Set><Type>
Retek_POPhyDesc</Type><Fmt>CwXML</Fmt></mcd>

This property is not valid if the value of BrokerType is ICS. Also, it is valid only if
the value of the DeliveryTransport property is JMS, and the value of the
WireFormat property is CwXML.

Possible values are mrm and xml. The default value is mrm.

SourceQueue

The SourceQueue property designates the JMS source queue for the connector
framework in support of guaranteed event delivery for [MS-enabled connectors

that use a JMS event store. For further information, see|“ContainerManagedEvents”]
i

This property is valid only if the value of DeliveryTransport is JMS, and a value for
ContainerManagedEvents is specified.

The default value is <CONNECTORNAME>/SOURCEQUEUE.

SynchronousRequestQueue

The SynchronousRequestQueue property delivers request messages that require a
synchronous response from the connector framework to the broker. This queue is
necessary only if the connector uses synchronous execution. With synchronous
execution, the connector framework sends a message to the synchronous request
queue and waits for a response from the broker on the synchronous response
queue. The response message sent to the connector has a correlation ID that
matches the ID of the original message.

This property is valid only if the value of DeliveryTransport is JMS.

The default value is <CONNECTORNAME>/SYNCHRONOUSREQUESTQUEUE

SynchronousRequestTimeout
The SynchronousRequestTimeout property specifies the time in milliseconds that
the connector waits for a response to a synchronous request. If the response is not
received within the specified time, the connector moves the original synchronous
request message (and error message) to the fault queue.

This property is valid only if the value of DeliveryTransport is JMS.

The default value is 0.
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SynchronousResponseQueue

The SynchronousResponseQueue property delivers response messages in reply to a
synchronous request from the broker to the connector framework. This queue is
necessary only if the connector uses synchronous execution.

This property is valid only if the value of DeliveryTransport is JMS.

The default is <CONNECTORNAME>/SYNCHRONOUSRESPONSEQUEUE

TivoliMonitorTransactionPerformance

The TivoliMonitorTransactionPerformance property specifies whether IBM Tivoli
Monitoring for Transaction Performance (ITMTP) is invoked at run time.

The default value is false.

WireFormat
The WireFormat property specifies the message format on the transport:

* If the value of the RepositoryDirectory property is a local directory, the value is
CwXML.

¢ If the value of the RepositoryDirectory property is a remote directory, the value
is CwBO.
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Appendix B. Connector Configurator Express

This appendix describes how to use Connector Configurator Express to set
configuration property values for your adapter.

You use Connector Configurator Express to:

* Create a connector-specific property template for configuring your connector
* Create a configuration file

* Set properties in a configuration file

The topics covered in this appendix are:

* [“Overview of Connector Configurator Express’]

+ |“Creating a connector-specific property template” on page 67]

+ [“Creating a new configuration file” on page 69|

+ |“Setting the configuration file properties” on page 72|

Overview of Connector Configurator Express

Connector Configurator Express allows you to configure the connector component
of your adapter for use with the InterChange Server Express integration broker.

You use Connector Configurator Express to:
* Create a connector-specific property template for configuring your connector.

* Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and, with InterChange Server Express, maps for use with
collaborations as well as specify messaging, logging and tracing, and data
handler parameters, as required.

Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator Express incorporates them
into your configuration file as soon as you create the file. However, you do need to
set the value of each standard property in Connector Configurator Express.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator Express
will show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties

and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
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your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 67]to set up a new one.

Starting Connector Configurator Express

You can start and run Connector Configurator Express in either of two modes:
* Independently, in stand-alone mode
* From System Manager

Running Configurator in stand-alone mode

You can run Connector Configurator Express without running System Manager
and work with connector configuration files, irrespective of your broker.

To do so:

 Start>All Programs, click IBM WebSphere Business Integration
Express>Toolset Express>Development>Connector Configurator Express.

* Select File>New>Connector Configuration.

* When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS.

You may choose to run Connector Configurator Express independently to generate
the file, and then connect to System Manager to save it in a System Manager
project (see|’Completing a configuration file” on page 71})

Running Configurator from System Manager

You can run Connector Configurator Express from System Manager.

To run Connector Configurator Express:

1. Open the System Manager.

2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator
Express. The Connector Configurator Express window opens and displays a
New Connector dialog box.

4. When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS.

To edit an existing configuration file:

* In the System Manager window, select any of the configuration files listed in the
Connector folder and right-click on it. Connector Configurator Express opens
and displays the configuration file with the integration broker type and file
name at the top.

* From Connector Configurator Express, select File>Open. Select the name of the
connector configuration file from a project or from the directory in which it is
stored.

* Click the Standard Properties tab to see which properties are included in this
configuration file.
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Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing connector definition as the template.

* To create a new template, see [‘Creating a new template” on page 67}

¢ To use an existing file, simply modify an existing template and save it under the
new name. You can find existing templates in your \ProductDir\bin\Data\App
directory.

Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template in Connector Configurator Express:
1. Click File>New>Connector-Specific Property Template.
2. The Connector-Specific Property Template dialog box appears.

* Enter a name for the new template in the Name field below Input a New
Template Name. You will see this name again when you open the dialog box
for creating a new configuration file from a template.

* To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template appears in the Template Preview
display.

3. You can use an existing template whose property definitions are similar to
those required by your connector as a starting point for your template. If you
do not see any template that displays the connector-specific properties used by
your connector, you will need to create one.

* If you are planning to modify an existing template, select the name of the
template from the list in the Template Name table below Select the Existing
Template to Modify: Find Template.

* This table displays the names of all currently available templates. You can
also search for a template.

Specifying general characteristics
When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:
* General:

Property Type

Property Subtype

Updated Method

Description
* Flags

Standard flags
e Custom Flag

Flag
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The Property Subtype can be selected when Property Type is a String. It is an
optional value which provides syntax checking when you save the configuration
file. The default is a blank space, and means that the property has not been
subtyped.

After you have made selections for the general characteristics of the property, click
the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1. Click the Value tab. The display panel for Value replaces the display panel for
General.

2. Select the name of the property in the Edit properties display.
3. In the fields for Max Length and Max Multiple Values, enter your values.

To create a new property value:
1. Right-click on the square to the left of the Value column heading.

2. From the pop-up menu, select Add to display the Property Value dialog box.
Depending on the property type, the dialog box allows you to enter either a
value, or both a value and a range.

3. Enter the new property value and click OK. The value appears in the Value
panel on the right.

The Value panel displays a table with three columns:

The Value column shows the value that you entered in the Property Value dialog
box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value dialog
box.

After a value has been created and appears in the grid, it can be edited from
within the table display.

To make a change in an existing value in the table, select an entire row by clicking
on the row number. Then right-click in the Value field and click Edit Value.

Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Po11Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventETimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1. In the Available Properties display, select the property that will be made
dependent.
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2. In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

3. In the Condition Operator field, select one of the following:
== (equal to)
!= (not equal to)
> (greater than)
< (less than)
>= (greater than or equal to)
<=(less than or equal to)

4. In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

5. With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

6. Click Finish. Connector Configurator Express stores the information you have
entered as an XML document, under \data\app in the \bin directory where you
have installed Connector Configurator Express.

Setting pathnames
Some general rules for setting pathnames are:

¢ The maximum length of a filename in Windows is 255 characters.

¢ In Windows, the absolute pathname must follow the format
[Drive:][Directory]\filename: for example,
C:\WebSphereAdapters\bin\Data\Std \StdConnProps.xml

* Queue names may not have leading or embedded spaces.

Creating a new configuration file

When you create a new configuration file, you must name it and select an
integration broker.

You also select an operating system for extended validation on the file. The toolbar
has a droplist called Target System that allows you to select the target operating
system for extended validation of the properties. The available options for
Windows is no extended validation (switches off extended validation). The default
on startup is Windows.

To start Connector Configurator Express:

* In the System Manager window, select Connector Configurator Express from
the Tools menu. Connector Configurator Express opens.

¢ In stand-alone mode, launch Connector Configurator Express.

To set the operating system for extended validation of the configuration file:
¢ Pull down the Target System: droplist on the menu bar.
* Select the operating system you are running on.

Then select File>New>Connector Configuration. In the New Connector window,
enter the name of the new connector.

You also need to select an integration broker. The broker you select determines the
properties that will appear in the configuration file. To select a broker:

* In the Integration Broker field, select ICS.
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* Complete the remaining fields in the New Connector window, as described later
in this chapter.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

1. Set the operating system for extended validation of the configuration file using
the Target System: droplist on the menu bar (see “Creating a new configuration
file” above).

2. Click File>New>Connector Configuration.
3. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator Express does not check the spelling of
the name that you enter. You must ensure that the name is
correct.

* System Connectivity
Click ICS.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

4. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector name. You can fill in all
the field values to complete the definition now, or you can save the file and
complete the fields later.

5. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running. If you save as a file, the Save File
Connector dialog box appears. Choose *.cfg as the file type, verify in the File
Name field that the name is spelled correctly and has the correct case, navigate
to the directory where you want to locate the file, and click Save. The status
display in the message panel of Connector Configurator Express indicates that
the configuration file was successfully created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

6. To complete the connector definition, enter values in the fields for each of the

tabs of the Connector Configurator Express window, as described later in this
chapter.

Using an existing file

You may have an existing file available in one or more of the following formats:
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* A connector definition file.This is a text file that lists properties and applicable
default values for a specific connector. Some connectors include such a file in a
\repository directory in their delivery package (the file typically has the
extension .txt; for example, CN_]JMS.txt for the JMS connector).

* An ICS repository file. Definitions used in a previous ICS implementation of the
connector may be available to you in a repository file that was used in the
configuration of that connector. Such a file typically has the extension .1in or
.out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.

Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *.cfg, or *.in file from a directory:
1. In Connector Configurator Express, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

¢ Configuration (x.cfg)
* ICS Repository (*.1in, =.out)

Choose this option if a repository file was used to configure the connector in
an ICS environment. A repository file may include multiple connector
definitions, all of which will appear when you open the file.

« All files (*.%)
Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator Express.

3. Click File>Open>From Project.

Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator Express window displays the configuration screen, with the current
attributes and values.

The title of the configuration screen displays the integration broker and connector
name as specified in the file. Make sure you have the correct broker. If not, change
the broker value before you configure the connector. To do so:

1. Under the Standard Properties tab, select the value field for the BrokerType
property. In the drop-down menu, select the value ICS.
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2. The Standard Properties tab will display the connector properties associated
with the selected broker. The table shows Property name, Value, Type, Subtype
(if the Type is a string), Description, and Update Method.

3. You can save the file now or complete the remaining configuration fields, as
described in [‘Specifying supported business object definitions” on page 75.

4. When you have finished your configuration, click File>Save>To Project or
File>Save>To File.

If you are saving to file, select *.cfg as the extension, select the correct location
for the file and click Save.

If multiple connector configurations are open, click Save All to File to save all
of the configurations to file, or click Save All to Project to save all connector
configurations to a System Manager project.

Before you created the configuration file, you used the Target System droplist
that allows you to select the target operating system for extended validation of
the properties.

Before it saves the file, Connector Configurator Express checks that values have
been set for all required standard properties. If a required standard property is
missing a value, Connector Configurator Express displays a message that the
validation failed. You must supply a value for the property in order to save the
configuration file.

If you have elected to use the extended validation feature by selecting a value
of Windows from the Target System droplist, the system will validate the
property subtype s well as the type, and it displays a warning message if the
validation fails.

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator Express displays a
configuration screen with tabs for the categories of required configuration values.

Connector Configurator Express requires values for properties in these categories
for connectors running on all brokers:

 Standard Properties

* Connector-specific Properties
* Supported Business Objects
* Trace/Log File values

» Data Handler (applicable for connectors that use JMS messaging with
guaranteed event delivery)

Note: For connectors that use JMS messaging, an additional category may display,
for configuration of data handlers that convert the data to business objects.

For connectors running on InterChange Server Express, values for these properties
are also required:

* Associated Maps
* Security

Important: Connector Configurator Express accepts property values in either
English or non-English character sets. However, the names of both
standard and connector-specific properties, and the names of supported
business objects, must use the English character set only.
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Standard properties differ from connector-specific properties as follows:

 Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* Value fields are configurable.

* The Update Method field is displayed for each property. It indicates whether a
component or agent restart is necessary to activate changed values. You cannot
configure this setting.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.

Note: If the property has a Type of String, it may have a subtype value in the
Subtype column. This subtype is used for extended validation of the
property.

3. After entering all the values for the standard properties, you can do one of the
following:

* To discard the changes, preserve the original values, and exit Connector
Configurator Express, click File>Exit (or close the window), and click No
when prompted to save changes.

* To enter values for other categories in Connector Configurator Express, select
the tab for the category. The values you enter for Standard Properties (or
any other category) are retained when you move to the next category. When
you close the window, you are prompted to either save or discard the values
that you entered in all the categories as a whole.

» To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

To get more information on a particular standard property, left-click the entry in
the Description column for that property in the Standard Properties tabbed sheet.
If you have Extended Help installed, an arrow button will appear on the right.
When you click on the button, a Help window will open and display details of the
standard property.
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Note: If the hot button does not appear, no Extended Help was found for that
property.

If installed, the Extended Help files are located in
<ProductDir>\bin\Data\Std \Help\ <RegionalSetting>\.

Setting connector-specific configuration properties

For connector-specific configuration properties, you can add or change property

names, configure values, delete a property, and encrypt a property. The default

property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.

Note: If the property has a Type of String, you can select a subtype from the
Subtype droplist. This subtype is used for extended validation of the
property.

3. To encrypt a property, select the Encrypt box.

4. To get more information on a particular property, left-click the entry in the
Description column for that property. If you have Extended Help installed, a
hot button will appear. When you click on the hot button, a Help window will
open and display details of the standard property.

Note: If the hot button does not appear, no Extended Help was found for that
property.
5. Choose to save or discard changes, as described for [“Setting standard connector]
[properties” on page 73.|

If the Extended Help files are installed and the AdapterHelpName property is
blank, Connector Configurator Express will point to the adapter-specific Extended
Help files located in <ProductDir>\bin\Data\ App\Help\ <RegionalSetting>\.
Otherwise, Connector Configurator Express will point to the adapter-specific
Extended Help files located in
<ProductDir>\bin\Data\ App\Help\ <AdapterHelpName>\ <RegionalSetting>\. See
the AdapterHelpName property described in the Standard Properties appendix.

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Connector-specific Properties window. To decrypt a value, click to clear
the Encrypt check box, enter the correct value in the Verification dialog box, and
click OK. If the entered value is correct, the value is decrypted and displays.

The adapter user guide for each connector contains a list and description of each
property and its default value.
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If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method
Refer to the descriptions of update methods found in the Standard Properties

appendix, under "Standard connector properties overview’l“Standard connector{
[properties overview” on page 45]

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator Express to
specify the business objects that the connector will use. You must specify both
generic business objects and application-specific business objects, and you must
specify associations for the maps between the business objects.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications.

InterChange Server Express as your broker

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name: To designate that a business object definition is supported
by the connector, with System Manager running:

1. Click an empty field in the Business Object Name list. A drop list displays,
showing all the business object definitions that exist in the System Manager
project.

2. Click on a business object to add it.

3. Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator Express window, click Save to
Project. The revised connector definition, including designated support for the
added business object definition, is saved to an ICL (Integration Component
Library) project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator Express window, click
Delete Row. The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support: If a business object has Agent Support, the system will attempt to

use that business object for delivering data to an application via the connector
agent.
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Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator Express window does not
validate your Agent Support selections.

Maximum transaction level: The maximum transaction level for a connector is
the highest transaction level that the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

Associated maps

Each connector supports a list of business object definitions and their associated
maps that are currently active in InterChange Server Express. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:
* Business Object Name

These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator Express window.

* Associated Maps
The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit Binding
In some cases, you may need to explicitly bind an associated map.
Explicit binding is required only when more than one map exists for a particular
supported business object. When InterChange Server Express boots, it tries to
automatically bind a map to each supported business object for each connector.

If more than one map takes as its input the same business object, the server
attempts to locate and bind one map that is the superset of the others.
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If there is no map that is the superset of the others, the server will not be able to

bind the business object to a single map, and you will need to set the binding

explicitly.

To explicitly bind a map:

1. In the Explicit column, place a check in the check box for the map you want
to bind.

2. Select the map that you intend to associate with the business object.

3. In the File menu of the Connector Configurator Express window, click Save
to Project.

4. Deploy the project to InterChange Server Express.
5. Reboot the server for the changes to take effect.

Security

You can use the Security tab in Connector Configurator Express to set various
privacy levels for a message. You can only use this feature when the
DeliveryTransport property is set to JMS.

By default, Privacy is turned off. Check the Privacy box to enable it.
The Keystore Target System Absolute Pathname is:

For Windows:
<ProductDir>\connectors\security\<connectorname>.jks

This path and file should be on the system where you plan to start the connector,
that is, the target system.

You can use the Browse button at the right only if the target system is the one
currently running. It is greyed out unless Privacy is enabled and the Target System
in the menu bar is set to Windows.

The Message Privacy Level may be set as follows for the three messages categories
(All Messages, All Administrative Messages, and All Business Object Messages):

"rr,

. : is the default; used when no privacy levels for a message category have
been set.

* none: Not the same as the default: use this to deliberately set a privacy level of
none for a message category.

* integrity
* privacy

* integrity_plus_privacy

The Key Maintenance feature lets you generate, import and export public keys for
the server and adapter.

* When you select Generate Keys, the Generate Keys dialog box appears with the
defaults for the keytool that will generate the keys.

* The keystore value defaults to the value you entered in Keystore Target System
Absolute Pathname on the Security tab.

* When you select OK, the entries are validated, the key certificate is generated
and the output is sent to the Connector Configurator Express log window.
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Before you can import a certificate into the adapter keystore, you must export it
from the server keystore. When you select Export Adapter Public Key, the Export
Adapter Public Key dialog box appears.

* The export certificate defaults to the same value as the keystore, except that the
file extension is <filename>.cer.

When you select Import Server Public Key, the Import Server Public Key dialog
box appears.

* The import certificate defaults to <ProductDir>\bin\ics.cer (if the file exists on
the system).

* The import Certificate Association should be the server name. If a server is
registered, you can select it from the droplist.

The Adapter Access Control feature is enabled only when the value of
DeliveryTransport is IDL. By default, the adapter logs in with the guest identity. If
the Use guest identity box is not checked, the Adapter Identity and Adapter
Password fields are enabled.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator Express uses the logging and tracing values of that file as
default values. You can change those values in Connector Configurator Express.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

¢ To console (STDOUT): Writes logging or tracing messages to the STDOUT
display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

¢ To File: Writes logging or tracing messages to a file that you specify. To
specify the file, click the directory button (ellipsis), navigate to the preferred
location, provide a file name, and click Save. Logging or tracing message are
written to the file and location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .10og and .txt are typical file extensions.

Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Not all adapters make use of data handlers.

See the descriptions under ContainerManagedEvents in Appendix A, Standard
Properties, for values to use for these properties.

78 Adapter for eMatrix User Guide



Saving your configuration file

When you have finished configuring your connector, save the connector
configuration file. Connector Configurator Express saves the file in the broker
mode that you selected during configuration. The title bar of Connector
Configurator Express always displays the broker mode that InterChange Server
Express is currently using.

The file is saved as an XML document. You can save the XML document in three

ways:

* From System Manager, as a file with a *.con extension in an Integration
Component Library, or

* In a directory that you specify.

* In stand-alone mode, as a file with a *.cfg extension in a directory folder. By
default, the file is saved to \WebSphereAdapters\bin\Data\App.

For details about using projects in System Manager, and for further information
about deployment, see the System Implementation Guide.

Changing a configuration file

You can change the integration broker setting for an existing configuration file.
This enables you to use the file as a template for creating a new configuration file,
which can be used with a different broker.

Note: You will need to change other configuration properties as well as the broker
mode property if you switch integration brokers.

To change your broker selection within an existing configuration file (optional):

* Open the existing configuration file in Connector Configurator Express.

* Select the Standard Properties tab.

* In the BrokerType field of the Standard Properties tab, select the value that is
appropriate for your broker. When you change the current value, the available
tabs and field selections in the properties window will immediately change, to

show only those tabs and fields that pertain to the new broker you have
selected.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator Express in a globalized environment

Connector Configurator Express is globalized and can handle character conversion
between the configuration file and the integration broker. Connector Configurator
Express uses native encoding. When it writes to the configuration file, it uses
UTE-8 encoding.
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Connector Configurator Express supports non-English characters in:
* All value fields
* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the
drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.

For example, to add the locale en_GB to the list of values for the Locale property,
open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"

isRequired="true"

updateMethod="component restart">

<ValidType>String</ValidType>
<ValidValues>

<Value>ja_JP</Value>
<Value>ko_KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>

<DefaultValue>en US</DefaultValue>
</ValidValues>
</Property>
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Appendix C. Sample scenario

This appendix contains a working sample of an eMatrix scenario. It demonstrates
how you can use the adapter for eMatrix to integrate eMatrix with other
applications and technologies supported by WebSphere Business Integration
adapters.

Topics covered in this appendix include:

* |“Overview” on page 81|

+ [“Assumptions” on page 81|

* [“Installing the scenario” on page 81|

+ [“Running the scenario” on page 85

Overview

In this simple example, the eMatrix adapter exchanges information with the Visual
Test Connector. We will assume that the Visual Test Connector represents a
computer parts procurement system. As parts become available, their availability is
communicated to the computer manufacturer, who uses the eMatrix adapter to
automatically update their eMatrix system. When the computer manufacturer’s
parts requirements change, the changes are automatically detected and sent to the
procurement system.

Assumptions

The assumptions are:

1. You have installed, and are experienced with, one of the supported integration
brokers (see Chapter 2 for details).

2. You have installed and are experienced with eMatrix version 9.6.0.1 and one of
its collaboration servers.

Installing the scenario

The first step is to set up eMatrix and create the eMatrix business object types.

Note: %SAMPLE_FOLDER% refers to the folder in which you found this
document.
%WBIA% refers to the folder containing your current WebSphere Business
Integration Adapters installation.

Defining eMatrix business object types

First, you define the types which represent the parts of a computer system. To do
this:

1. Open the eMatrix MQL shell.

2. Cut and paste the following commands into the shell:

#BEGIN
#1. create the attributes

add attribute "component cost" type real;
add attribute "in stock" type boolean;
add attribute "date available" type date;
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add attribute "component manufacturer" type string;
add attribute megahertz type integer;
add attribute slot type integer;

#2. create the types

add type bundle;

add type computer;

add type cpu attribute "component cost" attribute "in stock" attribute
"date available"

attribute "component manufacturer" attribute megahertz;

add type "network card" attribute "component cost" attribute "in stock"
attribute "date available" attribute "component manufacturer";

add type "usb 2.0 card" attribute "component cost" attribute "in stock"
attribute "date available" attribute "component manufacturer";

add type "sound card" attribute "component cost" attribute "in stock"
attribute "date available" attribute "component manufacturer";

add type "sound chip" attribute "component cost" attribute "in stock"
attribute "date available" attribute "component manufacturer"

attribute megahertz;

#3. create the relationships

add relationship "bundle to computer"' to type computer cardinality n from
type bundle cardinality n;

add relationship "computer to pci component" to type "network card",
"sound card", "usb 2.0 card" cardinality n from type computer

cardinality 1 attribute slot;

add relationship "sound card to sound chip" to type "sound chip"
cardinality 1 from type "sound card" cardinality 1;

#4. create policy
add policy "computer manufacturing" type bundle, computer, cpu,

"network card", "usb 2.0 card", "sound card", "sound chip" state
"pre production" state "ready for production";

#5. create vault

add vault "wbi computer manufacturer";
#6. create the "adapter" person

add person adapter password wbia type business, system access all admin all;

#END

Note that step 6 above gives the user "adapter” permission to perform all
operations in the system. Not all these privileges are required to run this example.
The following MQL command provides all those necessary:

add person adapter password wbia type business access all
admin none;

However, if you use the eMatrix adapter for tasks not covered in these samples,
you may need the privileges provided in step 6.

Creating eMatrix business object types
Next, you create the data that represents the computer system of the hypothetical
computer manufacturer. To do this:
1. Open the eMatrix MQL shell.
2. Cut and paste the following commands into the shell:

#business objects

add bus bundle "home office and entertainment" 1
policy "computer manufacturing"
vault "wbi computer manufacturer";

add bus computer "gamer deluxe" 1
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policy "computer manufacturing"

vault "wbi computer manufacturer";
add bus cpu "max processor" 1
policy "computer manufacturing"
vault "wbi computer manufacturer"
megahertz 2000
"in stock " true
'date available " 9/30/01
"component manufacturer" acetech
"component cost " 67;
add bus "sound card" "super sonic" 1
policy "computer manufacturing"
vault "wbi computer manufacturer"
"in stock " false
"date available" 6/12/03
"component cost" 50

"component manufacturer" "feedback inc.";
add bus "sound chip" "super sound chip" 1

policy "computer manufacturing"
vault "wbi computer manufacturer"
"component manufacturer" ChipsWeMake
megahertz 100;
add bus "usb 2.0 card" "usb enabler" 1
policy "computer manufacturing"
vault "wbi computer manufacturer"
"in stock" ' true
"date available ! 2/10/02
"component manufacturer" usbworks
""component cost" 12,
add bus "network card" "net connector" 1
policy "computer manufacturing"
vault "wbi computer manufacturer"
"in stock " true
"date available ! 8/12/02
"component cost"' 10
"component manufacturer" "tcp specialists";
#relationships

connect bus bundle "home office and entertainment" 1 relationship

"bundle to computer" to computer "gamer deluxe" 1;

connect bus computer "gamer deluxe" 1 relationship "computer to pci component"
to "sound card" "super sonic" 1

slot 1;

connect bus computer "gamer deluxe" 1 relationship "computer to pci component"
to "usb 2.0 card" "usb enable" 1

slot 2;

connect bus "sound card" "super sonic" 1 relationship "sound card to

sound chip" to "sound chip" "super sound chip" 1;

Installing the JPOs

You will need to install two JPOs, one to create the WebSphere Business Integration
Server Express event and archive event types, and one to act as a trigger when
detecting events.

1. Open the eMatrix Business Modeler and log in as a user with the ability to
create a program.

Select Object>new>program.

In the text box titled Name, enter WBIEventLogger.
Choose Java for the Type.

Click the Code tab.

Cut and paste the code from the
%WBIA%\ connector\eMatrix\dependencies\WBIEventLogger.java file into the
text box on this tab.

o0 kw0
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7.

You may need to set the ‘'wbiPrefix” and ‘vault’ values in the source code.
Please review the comments in the code for more information.

Click Create.

Follow the same steps to create the InstallEventTables program, with these
differences:

Name the program InstallEventTables.

Cut and paste the code from the
%WBIA %\ connector \eMatrix\dependencies\InstallEventTables.java file.

Installing the triggers

In this section, you create a trigger which will detect when the hypothetical
computer design changes. You create the trigger on the ‘computer to pci
component’ relationship. To do this:

1.

N Ok~

8.

In the eMatrix Business Modeler, click on the binoculars in the upper left-hand
corner of the window.

Select Relationship and click Find.

Double-click the ‘computer to pci component” business object.

In the new window, select the Triggers tab and click Add.

Select the Create trigger and click OK.

In the new window, type WBIEventLogger in the Action text box.
Type the following into the Input text box:

-method recordEvent ${FROMOBJECTID} n=wbi_computer_poll v=Update
Click OK, then click Edit to finish creating the trigger.

Installing the event business objects

The final step in installing the scenario is to install the event business objects. To
do so, execute this command from the MQL command line:

exec program InstallEventTables;

Configuring the eMatrix adapter

The first step is to configure the eMatrix connector. To do this:

1.
2.

Run the Connector Configurator Express.
Open %SAMPLE_FOLDER%\EmatrixConnector.cfg and set these properties:

RepositoryDirectory property = %SAMPLE_FOLDER%\repos

Pol1Frequency property = key

Set the ApplicationUserName and ApplicationPassword properties to the user
on whose behalf the connector will be running.

Set the eMatrixServer property to the name of the eMatrix server you will be
connecting to.

Set the HostName property to the URL, including the port, of the eMatrix
collaboration server that the adapter will be communicating with.

Set the EventVault property to the name of the vault which will store your
events.

You may create a new vault to store events. To do so, run the MQL eMatrix
client and type ‘add vault <vaultname>" in the text box at the bottom of the
window. Make sure that the this value matches the value of the vault string in
the WBIEventLogger JPO. By default both values should be "WBI_Events’.

Set the KeepRelations property to "true’.
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8. Open %SAMPLE_FOLDER%\PortConnector.cfg and set these properties:
RepositoryDirectory = %SAMPLE_FOLDER%\repos

Supporting business objects
For the adapter to use business objects, it must first support them. To provide
support for the business objects you want to use, do this:

1. With the Connector Configurator Express open, select the Supported Business
Objects tab and add these business objects:

* wbi_computer

* wbi_computer_poll
2. Check the Agent supported box next to each business object.
3. Repeat the steps above with the Port connector.

Creating queues
This sample scenario requires that several queues be defined in your queue
manager. To create the necessary queues, type:

RUNMQSC crossworlds.queue.manager

from the command line and issue the following commands:

DEFINE QL ("ADMININQUEUE")

DEFINE QL("ADMINOUTQUEUE")

DEFINE QL("DELIVERYQUEUE")

DEFINE QL("FAULTQUEUE")

DEFINE QL("REQUESTQUEUE")

DEFINE QL ("RESPONSEQUEUE")

DEFINE QL("EMATRIXCONNECTOR/RESPONSEQUEUE")

DEFINE QL ("SYNCHRONOUSREQUESTQUEUE")

DEFINE QL("SYNCHRONOUSRESPONSEQUEUE")

DEFINE QL("PORTCONNECTOR/SYNCHRONOUSREQUESTQUEUE")
DEFINE QL("PORTCONNECTOR/SYNCHRONOUSRESPONSEQUEUE")

Update the start script by opening either the start_eMatrix.bat or start_eMatrix.sh
file (depending on your platform) and setting the EMADK and EM_LIB variables
in these files.

Running the scenario

This example provides scenarios for two activities; request processing and event
notification.

Scenario 1: request processing

In the request processing scenario the procurement system informs the eMatrix
system that one of the components used in a design is now available. The system
sends a business object that represents the updated system component.

Start the Visual test connector

1. Select Start>Programs>WebSphere Business Integration
Adapters>Tools>Visual Test Connector. The connector starts.

2. In the connector window, select File>Create/Select Profile. The Connector
Profile window appears.

3. If you have not already done so, create a profile that emulates the Port
Connector in the profile window, as follows:

e Select File>New Profile.
¢ Click Browse and select the %SAMPLE_FOLDER% \PortConnector.cfg file.
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* In the Connector Name text box, type Port Connector.
From the Broker Type drop-down menu, select WMQIL

* Click OK.
4. If you have already created a profile, select it and click OK.

5. Once you have a profile, select File>Connect.

Start the adapter for eMatrix
Start the adapter for eMatrix by running this command:

%WBIA%\connectors\eMatrix\start_eMatrix.bat eMatrix wmqi
-c%SAMPLE_FOLDER%\EmatrixConnector.cfg

You can substitute any combination of alphanumeric characters (starting with a
letter) for the value of “wmqi”.

Start the eMatrix components

Start the eMatrix Collaboration server. Make sure that the instance of Oracle in
which the eMatrix system exists is running. Then open an MQL Command
window.

Check the current status in eMatrix
At the MQL command line, type this command:

expand bus "computer" "gamer deluxe" 1 select bus

"attribute[in stock]";

Note that the supersonic sound card is not in stock.

Send a request
To do this, follow these steps.

1. In the Visual Test Connector, select Edit>Load BO.

2. Select the file %SAMPLE_FOLDER%\sound_card_update.bo.
3. Enter any name in the popup window and click OK.
4

. Click Send BO in the upper left-hand corner of the Visual Test Connector. The
icon contains one yellow arrow.
You will see text messages appear in the window containing the adapter for
eMatrix. These message indicate that the request is being processed.

Check the updated status in eMatrix
Type the following at the MQL command line:

expand bus "computer" "gamer deluxe" 1 select bus
"attribute[in stock]";

Note that the supersonic sound card is now in stock.

Reset the status in the database
In order to run this scenario again, you must reset the supersonic sound card so
that it is not in stock.To do so, run this MQL command:

modify bus "sound card" "super sonic" 1 "in stock" false;

Scenario 2: event notification

In this scenario, the computer manufacturer changes the configuration of one of its
computer systems. The change will trigger a notification to be forwarded to the
procurement system.

1. Repeat steps 1 through 3 from scenario 1 above.
2. Follow the steps below.
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Update the computer configuration
The computer configuration has changed. The computer manufacturer is adding a
network card to the computer. At the MQL command line, run:

connect bus "computer" "gamer deluxe" 1 relationship
"computer to pci component' to "network card" "net

connector" 1 slot 3;

Poll the event
Go to the command window containing the adapter for eMatrix. At the bottom of
the window, type p’. This causes the adapter to poll.

View the event
The adapter will record the new computer configuration and forward it to the
procurement system (in this case, the Visual Test Connector).

Look in the window pane on the right of the Visual Test Connector. You will see a
line containing the text ‘'wbi_computer.Update’. This is the new computer
configuration represented as a WebSphere business object. You can double-click on
it to see its contents.

Reset the computer configuration
To run this scenario again, you must disconnect the eMatrix business objects. To do
so, run this command:

disconnect bus "computer" "gamer deluxe" 1 relationship
"computer to pci component" to "network card"

"net connector" 1;
This completes the installation and testing of the sample scenarios. If you have

performed all the steps above successfully, you should have a working sample that
enables the adapter for eMatrix.
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Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM RTP Laboratory
3039 Cornwallis Road
P.O. BOX 12195
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Raleigh, NC 27709-2195
US.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not necessarily tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information may contain examples of data and reports used in daily business

operations. To illustrate them as completely as possible, the examples may include

the names of individuals, companies, brands, and products. All of these names are

fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:
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IBM

the IBM logo
AIX
CrossWorlds
DB2

DB2 Universal Database
Domino
Lotus

Lotus Notes
MQIntegrator
MQSeries
Tivoli
WebSphere

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of
others.

Websphere Business Integration Server Express and Express Plus software
developed by the Eclipse Projct (http://www.eclipse.org/)

e
JAVA.

WebSphere Business Integration Server Express Version 4.4, and WebSphere
Business Integration Server Express Plus, Version 4.4
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